Configuration and client installation guide

For:

Nuance®
Dragon® Professional
Group

Nuance®
Dragon® Legal
Group

Nuance®
Dragon®
Law Enforcement
Copyright

2016 Dragon Professional Group and Dragon Legal Group, 14.

Nuance® Management Center.

This material may not include some last-minute technical changes and/or revisions to the software. Changes are periodically made to the information provided here. Future versions of this material will incorporate these changes.

Nuance Communications, Inc. has patents or pending patent applications covering the subject matter contained in this document. The furnishing of this document does not give you any license to such patents.

No part of this manual or software may be reproduced in any form or by any means, including, without limitation, electronic or mechanical, such as photocopying or recording, or by any information storage and retrieval systems, without the express written consent of Nuance Communications, Inc. Specifications are subject to change without notice.

Copyright © 2002-2016 Nuance Communications, Inc. All rights reserved.

Nuance, ScanSoft, the Nuance logo, the Dragon logo, Dragon, DragonBar, NaturallySpeaking, NaturallyMobile, RealSpeak, Nothing But Speech (NBS), Natural Language Technology, Select-and-Say, MouseGrid, and Vocabulary Editor are registered trademarks or trademarks of Nuance Communications, Inc. in the United States or other countries. All other names and trademarks referenced herein are trademarks of Nuance Communications or their respective owners. Designations used by third-party manufacturers and sellers to distinguish their products may be claimed as trademarks by those third-parties.

Disclaimer

Nuance makes no warranty, express or implied, with respect to the quality, reliability, currentness, accuracy, or freedom from error of this document or the product or products referred to herein and specifically disclaims any implied warranties, including, without limitation, any implied warranty of merchantability, fitness for any particular purpose, or noninfringement.

Nuance disclaims all liability for any direct, indirect, incidental, consequential, special, or exemplary damages resulting from the use of the information in this document. Mention of any product not manufactured by Nuance does not constitute an endorsement by Nuance of that product.

Notice

Nuance Communications, Inc. is strongly committed to creating high quality voice and data management products that, when used in conjunction with your own company’s security policies and practices, deliver an efficient and secure means of managing confidential information.

Nuance believes that data security is best maintained by limiting access to various types of information to authorized users only. Although no software product can completely guarantee against security failure, Dragon Group software contains configurable password features that, when used properly, provide a high degree of protection.

We strongly urge current owners of Nuance products that include optional system password features to verify that these features are enabled! You can call our support line if you need assistance in setting up passwords correctly or in verifying your existing security settings.

Published by Nuance Communications, Inc., Burlington, Massachusetts, USA

# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragon_InstallationGuideCover_20160929_v1</td>
<td>1</td>
</tr>
<tr>
<td>About this guide</td>
<td>viii</td>
</tr>
<tr>
<td>Guide overview</td>
<td>ix</td>
</tr>
<tr>
<td>Audience</td>
<td>ix</td>
</tr>
<tr>
<td>Additional resources</td>
<td>x</td>
</tr>
<tr>
<td>Documentation</td>
<td>x</td>
</tr>
<tr>
<td>Training</td>
<td>x</td>
</tr>
<tr>
<td>Support</td>
<td>x</td>
</tr>
<tr>
<td>Chapter 1: Introduction</td>
<td>1</td>
</tr>
<tr>
<td>About Nuance Management Center</td>
<td>2</td>
</tr>
<tr>
<td>Physical architecture</td>
<td>3</td>
</tr>
<tr>
<td>Chapter 2: Installation checklists</td>
<td>4</td>
</tr>
<tr>
<td>Checklist—Planning the server installation</td>
<td>5</td>
</tr>
<tr>
<td>Checklist—Planning the client installation</td>
<td>6</td>
</tr>
<tr>
<td>Chapter 3: Preparing for your server installation</td>
<td>7</td>
</tr>
<tr>
<td>Software requirements—Server</td>
<td>8</td>
</tr>
<tr>
<td>Application server and database server</td>
<td>8</td>
</tr>
<tr>
<td>NMC console</td>
<td>9</td>
</tr>
<tr>
<td>Hardware requirements—Server</td>
<td>10</td>
</tr>
<tr>
<td>Server installation prerequisites</td>
<td>11</td>
</tr>
<tr>
<td>Application server and database server</td>
<td>11</td>
</tr>
<tr>
<td>NMC console prerequisites</td>
<td>11</td>
</tr>
<tr>
<td>Other considerations</td>
<td>12</td>
</tr>
<tr>
<td>Network bandwidth recommendations</td>
<td>12</td>
</tr>
<tr>
<td>Excluding files and folders from anti-virus protection</td>
<td>12</td>
</tr>
<tr>
<td>Using a network traffic switch</td>
<td>12</td>
</tr>
<tr>
<td>Obtaining required server software</td>
<td>14</td>
</tr>
<tr>
<td>Opening required ports</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 4: Installing the servers</td>
<td>16</td>
</tr>
<tr>
<td>Installing SQL Server</td>
<td>17</td>
</tr>
<tr>
<td>Installing Nuance Management Center</td>
<td>18</td>
</tr>
<tr>
<td>Chapter 5: Post-installation tasks</td>
<td>24</td>
</tr>
<tr>
<td>Contents</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Supported Virtual Desktop infrastructure applications</td>
<td>58</td>
</tr>
<tr>
<td>Required skills for installing Dragon Group</td>
<td>59</td>
</tr>
<tr>
<td>Dragon File Structure</td>
<td>60</td>
</tr>
<tr>
<td>Windows 7, Windows 8.x, and Windows 10</td>
<td>60</td>
</tr>
<tr>
<td>Accessing program files</td>
<td>61</td>
</tr>
<tr>
<td>Assigning access</td>
<td>62</td>
</tr>
<tr>
<td>Assigning permissions</td>
<td>62</td>
</tr>
<tr>
<td>Configuring client workstations</td>
<td>63</td>
</tr>
<tr>
<td>Turning off Windows Automatic Updates</td>
<td>63</td>
</tr>
<tr>
<td>Anti-virus recommendations</td>
<td>63</td>
</tr>
<tr>
<td>Recommended virtual memory settings</td>
<td>63</td>
</tr>
<tr>
<td>Chapter 9: Installing the Dragon Group client</td>
<td>64</td>
</tr>
<tr>
<td>Chapter 10: Installing the Dragon client with Settings</td>
<td>65</td>
</tr>
<tr>
<td>Overview—Installing the Dragon client with initial settings</td>
<td>66</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>66</td>
</tr>
<tr>
<td>Push installations</td>
<td>66</td>
</tr>
<tr>
<td>Support for SMS and Windows Server with Active Directory</td>
<td>67</td>
</tr>
<tr>
<td>Installing the same Dragon configuration on multiple computers</td>
<td>68</td>
</tr>
<tr>
<td>Performing an administrative installation with a batch file</td>
<td>69</td>
</tr>
<tr>
<td>Understanding the script in admininstall.bat</td>
<td>69</td>
</tr>
<tr>
<td>Modifying admininstall.bat</td>
<td>69</td>
</tr>
<tr>
<td>Command Line installation with msiexec.exe</td>
<td>70</td>
</tr>
<tr>
<td>Installing the same configuration on additional computer(s)</td>
<td>70</td>
</tr>
<tr>
<td>Chapter 11: Configuring the Dragon client for NMS</td>
<td>71</td>
</tr>
<tr>
<td>Associating Dragon clients with the NMC server or Local Authenticator</td>
<td>72</td>
</tr>
<tr>
<td>Converting from Stand-Alone to NMS mode</td>
<td>73</td>
</tr>
<tr>
<td>Chapter 12: Scheduling Optimization Tasks</td>
<td>74</td>
</tr>
<tr>
<td>Using Acoustic and Language Model Optimizer and Scheduler tools</td>
<td>75</td>
</tr>
<tr>
<td>Checking the optimization status of a user profile</td>
<td>75</td>
</tr>
<tr>
<td>Running the Acoustic and Language Model Optimizers from the DragonBar</td>
<td>75</td>
</tr>
<tr>
<td>Running the Acoustic and Language Model Optimizer from the Start menu</td>
<td>76</td>
</tr>
<tr>
<td>Chapter 13: Working with Custom Commands</td>
<td>78</td>
</tr>
<tr>
<td>Using the Convert XML to DAT Tool</td>
<td>79</td>
</tr>
<tr>
<td>Starting the Convert XML to DAT tool</td>
<td>79</td>
</tr>
<tr>
<td>Convert XML to DAT syntax</td>
<td>79</td>
</tr>
<tr>
<td>Use the XML to DAT tool to convert data in an XML file</td>
<td>79</td>
</tr>
</tbody>
</table>
Using the MyCommands Protection Utility .................................................... 80

Chapter 14: Upgrading the Dragon client ..................................................... 81
Preparing to upgrade Dragon ................................................................. 82
Export user profiles ............................................................................... 82
Optional: Export custom words ............................................................ 82
Optional: Export custom commands ...................................................... 82
Upgrading Roaming User Profiles ......................................................... 84
Before you upgrade .............................................................................. 84
After upgrading Roaming user profiles .................................................. 85
Upgrading Your Dragon installation from the Command Line ............... 86
Upgrading with settings ....................................................................... 86
Upgrading from the command line ....................................................... 86
Using setup.exe for silent upgrades ..................................................... 86
Upgrading with msiexec.exe ................................................................. 88
Upgrading user profiles ....................................................................... 90
Running the Upgrade User Profiles Wizard ......................................... 90
Importing custom words and commands ............................................. 91

Chapter 15: Managing Logs and Errors ..................................................... 92
Dragon logs .......................................................................................... 93
Dragon client logs ............................................................................... 93
Usability logs (Stand-Alone mode only) ................................................. 94
Handling Dragon error messages ......................................................... 95
Accessing the Dragon Knowledge Database ....................................... 96

Chapter 16: Using Dragon over a remote desktop connection ................. 97
Use Dragon through a remote desktop connection ................................ 98
Remote desktop connection support .................................................... 99
Support for dictation sources over a remote desktop connection ........... 99
System Requirements for using Dragon through a remote desktop connection .......................................................... 99
Installing Dragon on the server and the client .................................... 101
Configuring the Windows server ......................................................... 102
Configuring Windows Server 2008 R2 ............................................... 103
Configuring Windows Server 2012 R2 Part 1 ....................................... 107
Configuring Windows 7 Ultimate Server .......................................... 112
Configuring the Dragon clients ........................................................... 113
User Profiles and using Dragon through a Remote Desktop session ...... 116

Appendix A: Options for MSI Installations .............................................. 117
Contents

MSI options for Dragon installations ................................................................. 118
Sample command lines .................................................................................. 121
Feature variables to set through the ADDLOCAL or ADVERTISE properties .......... 123
Speech options ............................................................................................... 124
MSI options for scheduled tasks ..................................................................... 126
Editing Miscellaneous and Scheduled Task settings in nsdefaults.ini ............... 127
Extracting MSI/MST Files from the Dragon setup.exe ...................................... 129

Appendix B: Stand-Alone Mode Installation Options ........................................ 131
Setting Roaming user profile options .............................................................. 132
Understanding Roaming user settings in nsdefaults.ini and roamingdef.ini ........ 133
nsdefaults.ini settings .................................................................................... 133
roamingdef.ini options ................................................................................... 135
Installing a Roaming user profile configuration on additional computers .......... 137

Appendix C: Database backups ......................................................................... 138
About database backups .................................................................................. 139
Disabling automatic database backups ............................................................ 140
About this guide

Guide overview ................................................................. ix
Audience ........................................................................... ix
Additional resources ......................................................... x
  Documentation .................................................................. x
  Training ........................................................................ x
  Support ........................................................................ x
Guide overview

The Server Installation and Client Configuration Guide provides the following:

- Installation and configuration instructions for on-premise Nuance Management Center (NMC) servers.
- Configuration instructions for single sign-on authentication.
- Installation, configuration, and upgrade instructions for Dragon Group clients.

This guide contains installation and configuration instructions for both clients using their own on-premise NMC server and clients using Nuance's hosted NMC server in the cloud. Use the following table to determine the chapters that are applicable to you:

<table>
<thead>
<tr>
<th>NMC server type</th>
<th>Applicable chapters</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-premise</td>
<td>1-6, 8-16, Appendix A, B, and C</td>
</tr>
<tr>
<td>Nuance-hosted</td>
<td>6-16, Appendix A and B</td>
</tr>
</tbody>
</table>

Audience

This guide is intended for IT administrators, database administrators, and Dragon administrators whose responsibility is to perform the following:

- Install and configure an on-premise NMC server.
- Set up and manage single sign-on user authentication.
- Install and manage a SQL Server database.
- Install Dragon clients and configure them through the Nuance Management Center (NMC) console.

This guide assumes you have experience in hardware configuration, software installation, database management, and networking.
Additional resources

The following resources are available in addition to this guide to help you manage your Dragon Group installation.

**Documentation**

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Dragon Group Release Notes</em></td>
<td>New features, system requirements, client upgrade instructions, and known issues.</td>
<td>Dragon client Help (Help&gt;Help Topics)</td>
</tr>
<tr>
<td><em>Nuance Management Center Help</em></td>
<td>Instructions for configuring and managing the Nuance Management Center (NMC) console and Dragon clients.</td>
<td>NMC console Help button (?)</td>
</tr>
<tr>
<td><em>Dragon Group client Help</em></td>
<td>Commands and instructions for dictating, correcting, and more with the Dragon client.</td>
<td>Dragon client Help (Help&gt;Help Topics)</td>
</tr>
</tbody>
</table>

**Training**

Nuance provides several Dragon training offerings, like webinars, demos, and Nuance University online training courses. For more information, see the Dragon Support web site.

**Support**

The Dragon Support web site provides many resources to assist you with your Dragon installation, like forums and a searchable knowledgebase. For more information on Support offerings, see the Dragon Support web site at:
Chapter 1: Introduction

- About Nuance Management Center ................................................................. 2
- Physical architecture ......................................................................................... 3
About Nuance Management Center

Nuance Management Center allows Dragon system administrators to manage all Dragon Group clients from a single central console. The console, called the Nuance Management Center (NMC) console, allows you to do the following:

- Configure options for clients at the site, group, or user level
- Centrally manage your Dragon product licensing
- Share data, like custom words and commands, with clients and across other Nuance products
- Audit user session events
- Monitor client usage and trends through reporting

Nuance Management Center installs on a server. You can choose to install, configure, and maintain your own on-premise NMC server, or you can use the Nuance-hosted server in the cloud.

Using Nuance Management Center with your Dragon Group installation is an optional feature that you enable in Dragon Group.
Physical architecture

The physical configuration of Nuance Management Center includes:

- **Application server**—The NMC server. Stores user accounts, settings, and administrative information. Can be a single machine, or, in large installations, can be multiple servers load-balanced by a network traffic switch. Can be the Nuance-hosted NMC server in the cloud, or a server that you install and host on-premise.

- **Database server**—Hosts the SQL database that stores your data, like sites, groups, and licenses. Can be the same physical machine as your application server.

- **Dragon clients**—Client computers with Dragon Group installed.

If you choose to host your own NMC server on-premise, there are two configuration options:

- **Single-tier**—Your application server and database server are located on the same physical machine.

- **Two-tier**—Your application server and database server run on separate machines.

If you’re hosting your own NMC server, the installation process installs the NMC server, database server, and NMC console from a single executable file. During the installation, you can choose the location of your database server.
Chapter 2: Installation checklists

Checklist—Planning the server installation ............................................................... 5
Checklist—Planning the client installation ............................................................... 6
Checklist—Planning the server installation

If you are installing and managing your own Nuance Management Center (NMC) server and database server on-premise, use this checklist to help you prepare for the installation.

<table>
<thead>
<tr>
<th>Server</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMC server and database server</td>
<td>Ensure all system requirements have been met.</td>
<td>“Software requirements—Server” on page 8</td>
</tr>
<tr>
<td>NMC server and database server</td>
<td>Ensure all prerequisites have been met.</td>
<td>“Server installation prerequisites” on page 11</td>
</tr>
<tr>
<td>NMC server</td>
<td>Obtain the required server software.</td>
<td>“Obtaining required server software” on page 14</td>
</tr>
<tr>
<td>NMC server and database server</td>
<td>Ensure required ports are open.</td>
<td>“Opening required ports” on page 15</td>
</tr>
<tr>
<td>Database server</td>
<td>Install the SSL certificate.</td>
<td>“Installing and binding the SSL certificate” on page 25</td>
</tr>
<tr>
<td>NMC server and database server</td>
<td>Install the required software.</td>
<td>“Installing SQL Server” on page 17</td>
</tr>
<tr>
<td>NMC server</td>
<td>Run the NMS_SuiteInstaller.exe file to install the NMC server, NMC console, and database.</td>
<td>“Installing Nuance Management Center” on page 18</td>
</tr>
<tr>
<td>NMC server</td>
<td>If you’re using multiple NMC servers, configure your network traffic switch.</td>
<td>“Configuring your network switch” on page 31</td>
</tr>
<tr>
<td>NMC server</td>
<td>Verify that the NMS Platform service is running.</td>
<td>“Verifying the NMS Platform service is running” on page 30</td>
</tr>
<tr>
<td>NMC server</td>
<td>Log in to the NMC console.</td>
<td>“Logging in to the Nuance Management Center (NMC) console” on page 32</td>
</tr>
<tr>
<td>Database server</td>
<td>Determine your database backup method.</td>
<td>“Determining your database backup method” on page 33</td>
</tr>
</tbody>
</table>
# Checklist—Planning the client installation

Use this checklist to help you prepare for client installations.

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign access to the necessary folders and Registry keys on client machines.</td>
<td>“Assigning access” on page 62</td>
</tr>
<tr>
<td>Configure client workstations.</td>
<td>“Configuring client workstations” on page 63</td>
</tr>
<tr>
<td>Perform an initial installation of the Dragon client using one of the following methods:</td>
<td>• “Initial Installation Using the Dragon InstallShield Wizard” on page 1</td>
</tr>
<tr>
<td>• Dragon InstallShield Wizard (recommended)</td>
<td>• “Installation Using the Dragon Command Line” on page 1</td>
</tr>
<tr>
<td>• Command line installation</td>
<td></td>
</tr>
<tr>
<td>Set up the configuration files as needed, then copy them to a directory you can access from other computers.</td>
<td>“Natspeak.exe Command Line Options” on page 1</td>
</tr>
<tr>
<td>Install the Dragon client on Dragon users’ machines using one of the following methods:</td>
<td>• “Installing the same Dragon configuration on multiple computers” on page 68</td>
</tr>
<tr>
<td>• Manual install from a DVD.</td>
<td>• “Command Line installation with msiexec.exe” on page 70</td>
</tr>
<tr>
<td>• Push install with an MSI.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3: Preparing for your server installation

Software requirements—Server .................................................................................................................. 8
  Application server and database server ................................................................................................ 8
  NMC console ........................................................................................................................................ 9
Hardware requirements—Server .............................................................................................................. 10
Server installation prerequisites ............................................................................................................ 11
  Application server and database server .................................................................................................. 11
  NMC console prerequisites .................................................................................................................. 11
Other considerations ............................................................................................................................. 12
  Network bandwidth recommendations ................................................................................................. 12
  Excluding files and folders from anti-virus protection ......................................................................... 12
  Using a network traffic switch .............................................................................................................. 12
Obtaining required server software ...................................................................................................... 14
Opening required ports .......................................................................................................................... 15
Software requirements—Server

If you’re hosting your own Nuance Management Center (NMC) server and database server on-premise, you must first download the Nuance Management Center installation package. When you purchase Nuance Management Center, Nuance sends you an email with a link to download the package. You must then ensure that your servers meet the following software requirements.

Application server and database server

The following table provides software requirements for the following scenarios:

- Your application server and database server are separate physical machines.
- Your application server and database server are on the same physical machine.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Application server</th>
<th>Database server</th>
<th>Combined application and database server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>One of the following:&lt;br&gt;  - Microsoft® Windows Server 2008 R2, Service Pack 1, Service Pack 2</td>
<td>One of the following:&lt;br&gt;  - Microsoft® Windows Server 2008 R2, Service Pack 1, Service Pack 2</td>
<td>One of the following:&lt;br&gt;  - Microsoft® Windows Server 2008 R2, Service Pack 1, Service Pack 2</td>
</tr>
<tr>
<td></td>
<td>- Microsoft® Windows Server 2012 R2 (64 bit)</td>
<td>- Microsoft® Windows Server 2012</td>
<td>- Microsoft® Windows Server 2012 R2 (64 bit)</td>
</tr>
<tr>
<td></td>
<td>Ensure you have all current service packs installed.</td>
<td></td>
<td>Ensure you have all current service packs installed.</td>
</tr>
</tbody>
</table>
## Chapter 3: Preparing for your server installation

### Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Application server</th>
<th>Database server</th>
<th>Combined application and database server</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>current service packs installed.</td>
<td></td>
</tr>
<tr>
<td>Windows components</td>
<td>• Microsoft .NET Framework 4.5.2 or later, including the ASP .NET component</td>
<td>None.</td>
<td>• Microsoft .NET Framework 4.5.2 or later, including the ASP .NET component</td>
</tr>
<tr>
<td></td>
<td>• Internet Information Services (IIS) 7, 7.5, or 8.0</td>
<td></td>
<td>• Internet Information Services (IIS) 7, 7.5, or 8.0</td>
</tr>
<tr>
<td>Security</td>
<td>• SSL certificate</td>
<td>None.</td>
<td>• SSL certificate</td>
</tr>
<tr>
<td></td>
<td>While Nuance Management Center supports self-signed certificates, Nuance strongly recommends that you use a certificate signed by a certificate authority.</td>
<td></td>
<td>While Nuance Management Center supports self-signed certificates, Nuance strongly recommends that you use a certificate signed by a certificate authority.</td>
</tr>
<tr>
<td></td>
<td>For more information on SSL certificates, see “Installing and binding the SSL certificate” on page 25.</td>
<td></td>
<td>For more information on SSL certificates, see “Installing and binding the SSL certificate” on page 25.</td>
</tr>
</tbody>
</table>

### NMC console

- Microsoft Internet Explorer 10 or 11, or latest version of Chrome
- Microsoft .NET Framework 4.5.2 or later
Hardware requirements—Server

If you’re hosting your own Nuance Management Center (NMC) server and database server on-premise, ensure the servers meet the following hardware requirements.

For every 1,000 users:

- One Quad-Core physical server to host the SQL database, NMC server, and NMC console
  - **Processor**: Quad-Core 2 GHz CPU
  - **Minimum RAM**: 4 GB recommended
  - **Core Application Disk Storage**: 40 GB for the NMC server

- **If using Roaming user profiles**: A server, separate machine, or RAID array to host the Master user profiles directory
  - **Processor**: Intel® Pentium® 4® or later, or AMD Athlon 64 or later
    - **CPU**: 1 GHz minimum (2.4 GHz recommended)
    - **RAM**: 4 GB
    - **Cache**: 512 KB minimum L2 Cache (1 MB recommended)

- One Database Server
  - **Processor**: Dual-Core 2GHz CPU
  - **Minimum RAM**: 4 GB
## Server installation prerequisites

In addition to the system requirements, you’ll also need the following.

### Application server and database server

<table>
<thead>
<tr>
<th>Prerequisite</th>
<th>Server</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows administrator account</td>
<td>Application</td>
<td>All services should run under this account. This account must also meet the following requirements:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Is an administrator account in the workgroup (single-tier) or in the domain (two-tier)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Account and password never expire</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Has rights to install software</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Has rights to install, create, and start a Windows service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Has full read/write access to the database server, and to all servers in the network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You provide this account name and password during the server installation.</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>To allow this account to launch the services upon installation completion, you must set it up with <strong>Log on as Service</strong> rights.</td>
</tr>
<tr>
<td></td>
<td>database</td>
<td></td>
</tr>
<tr>
<td>Computer name or IP address of your server</td>
<td>Application</td>
<td>Must be provided during the NMC server installation.</td>
</tr>
<tr>
<td></td>
<td>and database</td>
<td></td>
</tr>
<tr>
<td>Directory permissions</td>
<td>Application</td>
<td>Assign full read/write/modify permissions to the directories where the NMC server, NMC console, and database server are installed.</td>
</tr>
<tr>
<td></td>
<td>and database</td>
<td></td>
</tr>
</tbody>
</table>

### NMC console prerequisites

<table>
<thead>
<tr>
<th>Prerequisite</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full trust privileges</td>
<td>None.</td>
</tr>
</tbody>
</table>
Other considerations

Consider the following while you prepare for your NMC server installation.

Network bandwidth recommendations

Nuance recommends the following network bandwidth speeds for Nuance Management Center.

<table>
<thead>
<tr>
<th>Number of clients</th>
<th>Minimum network speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>10 Mbps</td>
</tr>
<tr>
<td>&gt;100</td>
<td>100 Mbps</td>
</tr>
</tbody>
</table>

Excluding files and folders from anti-virus protection

If you have anti-virus software installed on your application and database servers and Dragon clients, you should exclude the following files and folders from the anti-virus scan to ensure optimum performance.

Servers

- Nuance folder and all sub-folders
- **File extensions**: DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV

Clients

- C:\Program Files\Nuance folder and all sub-folders
- C:\Program Data\Nuance folder and all sub-folders
- C:\<windows user ID>\AppData folder and all sub-folders
- C:\Documents and Settings\All Users\Application Data\Nuance folder and all sub-folders
- C:\Documents and Settings\<windows user ID>\Local Settings\Temp folder
- **File extensions**: BD, BIN, DAT, DVC, ENH, GSB, GRM, GRX, INI, LCK, NWV, SIG, SVC, USR, VER, VOC, WAV, XML, LOG

Using a network traffic switch

If you have a large organization and you’re implementing more than one NMC server, you can include a network traffic switch in your network to balance the load on the servers.

The following table describes the recommended settings for your device.

<table>
<thead>
<tr>
<th>Component</th>
<th>Setting</th>
</tr>
</thead>
</table>
| Network Interface Card (NIC)—Gigabit cards | Automatic.  
Switches and gigabit cards must have the same setting. |
| Network Interface Card (NIC)—10/100Mb cards | Network link speed and duplex must be set the same on all servers, workstations,  
and other network equipment, or performance and recognition degradation could occur. |
<p>| Network speed—10 Mbps            | Full Duplex                                                             |</p>
<table>
<thead>
<tr>
<th>Component</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network speed—100 Mbps</td>
<td>Full Duplex</td>
</tr>
</tbody>
</table>
Obtaining required server software

The following server software is required. You can obtain the software from microsoft.com.

- Microsoft .NET Framework 4.5
- One of the following:
  - Microsoft® Windows Server 2008, Service Pack 1, Service Pack 2
  - Microsoft® Windows Server 2008 R2, 32-bit and 64-bit
  - Microsoft® Windows Server 2008 R2 64 bit Service Pack 2
  - Microsoft® Windows Server 2012
  - Microsoft® Windows Server 2012 R2 (64 bit)
# Opening required ports

You must open the following ports to allow communication between components.

<table>
<thead>
<tr>
<th>Port</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>389 TCP</td>
<td>NMC server</td>
<td>• Allows communication between the NMC server and your Active Directory, if you are using single sign-on authentication.</td>
</tr>
<tr>
<td>443</td>
<td>NMC server</td>
<td>• Allows communication between Dragon clients and the NMC server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Allows communication between NMC console workstations and the NMC server.</td>
</tr>
<tr>
<td>1433 Custom</td>
<td>Database server</td>
<td>• Allows communication between the NMC server and the database server if they are on separate physical machines.</td>
</tr>
</tbody>
</table>
Chapter 4: Installing the servers

Installing SQL Server ................................................................. 17
Installing Nuance Management Center ......................................... 18
Installing SQL Server

Use the following settings during your installation:

1. On the Feature Selection screen, select the following features:
   - Database Engine Services
   - Management Tools – Basic
   - Management Tools – Complete

   While using Nuance Management Center does not require you to install Analysis Services and Reporting Services, these services may help Nuance technical support troubleshoot any issues that occur with your installation or database.

2. On the Instance Configuration screen, leave the Default instance option selected.
3. On the Server Configuration screen, click Use the same account for all SQL Server Services.
   1. Enter the username and password of the Windows user account that the SQL Server services should all run under. Use the same account that the product services will run under.

      If you are planning to install the database and all Dragon Group servers on a single machine, Nuance recommends using an account in a workgroup. Enter the account in the format “Domain\User_Name.”

   2. Enter the password that other servers and clients on the Dragon Group network will use to access the database.

4. On the Database Engine Configuration screen:
   - Nuance recommends using Windows Authentication Mode for most networks.
   - Add at least three user accounts to administer the SQL database, including the account you created to run all NMS services.

5. On the Reporting Services Configuration screen, select Install the native mode default configuration.

6. If the Complete with failures screen appears, save the log to a location where you can retrieve it. The Nuance support team can use this log file if any network issues arise.
Caution:
Even if you do not want to store the data files in SQL Server’s default location, allow the installer to create the database, its transaction log, and its dump device in the default location. When the installation is complete, you can move the database and its files to a different location.

ADVANCED INSTALLERS ONLY: Alternatively, create the NuanceMC.mdf database, the NuanceMC_log.LDF transaction log, and the NuanceMCDump.bak dump device on your server before installing the NMC server.

1. On the NMC server (for single-node installations) or each node (for multiple-node installations), run NMS_SuiteInstaller.exe.
   The Choose Setup Language screen of the InstallShield Wizard opens.
2. Select a language from the drop-down list.
3. Click Next until you reach the License Agreement screen.
4. Accept the license agreement, and then click Install.
   The wizard installs several components of the NMS Suite, then the Customer Information screen appears:

   ![Image of Customer Information screen]

5. Enter a user name and company name, and then click Next.
The **Choose Destination Location** screen appears:

6. Choose where you want to install the NMS platform (default recommended), and then click **Next**.

The **Setup Type** screen appears:

7. Choose a setup configuration:
   - **Single-node installations**: Select **On a server with an SSL certificate installed directly on that server**.
   - **Multiple-node installations**: Select **Behind a networking device with an SSL certificate installed**.

8. Click **Next**.
The wizard installs NMS Suite components. When it is finished, the **Database Server** screen appears:

9. Enter the required database information:

   1. Enter the machine name or IP address of the physical server where you have installed the SQL Database Server software. The wizard creates the database and its backup directory in default locations on that server automatically.

   2. Under **Connect using**, select a method of validating connections to the server:

      - **Windows authentication**: Use a Windows login and password to authorize access.
      - **SQL Server authentication**: Use a SQL Server login and password.

      Choose the same type of authentication for access to the database that you chose when you installed the SQL Server. Nuance recommends using Windows authentication.

   3. **SQL Server authentication only**: Enter the database system administrator login name and password that you set up in the SQL Server into the **Login ID** and **Password** text boxes provided.

      These fields are not used for Windows authentication.

10. **Click Next.**
The wizard installs several NMS Suite components. When it is finished, the **Organization Id** screen appears:

11. Enter the unique ID that Nuance assigned to your organization. You should have received this ID with your Dragon Group software package.

   Later, you can access your organization ID in the NMC console. For more information on organization IDs, see the *Nuance Management Center Administrator Guide*.

12. Click **Next**.

   The **Enter new password for NMC** screen appears:

13. Enter a password for the default administrator account.
The first time you log into the NMC console, use the “admin” login ID with the password you created in this step.

14. Click **Next**.

The **Setup Type** screen appears:

15. Select the account type under which NMS windows service will run, and then click **Next**.

The **Service logon** screen appears:

16. Enter the user name and password of the Windows user account under which NMS will run, then click **Next**.
The install wizard installs several components, then opens the **Choose Destination Location** screen for the **NMC – InstallShield Wizard**:

![Image of Choose Destination Location screen]

17. Choose where you want the install wizard to install the NMC console (default recommended), and then click **Next**.

   The wizard installs the NMC console.

18. When the installation is complete, click **Finish**.

19. If the Windows Server 2008, 2012, or 2012 R2 firewall was turned on during the installation, you must now open port 443 so that the NMC console can communicate with the NMS platform.

20. Import your license key in the NMC console:
   1. In a supported browser, go to https://<servername>/nmchtml/.
   2. Log into the NMC console using the "admin" ID and the password you entered in the setup process.
   3. In the **Licensing** ribbon, click **Import License Key**.
   4. Enter your license key.

   For more information on license keys, see the *Nuance Management Center Administrator Guide*. 


Chapter 5: Post-installation tasks

Installing and binding the SSL certificate ................................................................. 25
  About certificates ........................................................................................................ 25
  Install the SSL certificate—Installing on the server .................................................. 25
  Install the SSL certificate—Installing on a load balancing switch .............................. 28
  Testing and troubleshooting your SSL configuration ................................................. 28
Verifying the NMS Platform service is running ......................................................... 30
  Starting the NMS Platform service manually ......................................................... 30
Configuring your network switch ................................................................................ 31
Logging in to the Nuance Management Center (NMC) console ................................. 32
Determining your database backup method .................................................................. 33
Installing and binding the SSL certificate

About certificates

Using SSL requires that you obtain an SSL certificate. Nuance Management Center supports both signed certificates from a certificate authority, and self-signed (or internally generated) certificates. However, Nuance strongly recommends that you use a signed certificate, as self-signed certificates are not always easily recognized by the client the same way signed certificates are.

You can obtain signed certificates from certificate authorities, such as GoDaddy or Verisign. The certificate authority must be a trusted authority known to both the client computer and the server.

To obtain a signed certificate, you'll need to provide information to the certificate authority about your organization and the server on which you are installing the certificate in the Certificate Signing Request (CSR). Each certificate authority may require different information. Typically, the information can include the following:

- Organization name
- Organization location information, such as town and state
- Computer name for the server on which you are installing the certificate
- Extended Key Usage value, such as 2.5.29.37. Extended key usage further refines key usage extensions, which define the purpose of the public key contained in the certificate.
- Key Size, such as 2048 bits or 4096 bits. Determines the length of the public key in the certificate. A longer key provides stronger security. You determine the level of security that is appropriate for your environment.

You obtain this information from your IT department, or from the person who installed and configured your server.

For more detailed information on installing SSL certificates, see:


Install the SSL certificate—Installing on the server

Clients contact the Local Authenticator on the standard HTTP ports 80 and 443.

1. Install an SSL certificate in the Personal Store under the Local Computer section for the "logon as" user account under which the NMS service is running.

   To add the Certificates Snap-in and view the certificates installed on the local computer, see https://technet.microsoft.com/en-us/library/cc754431(v=ws.11).aspx.
2. Note the subject of the certificate.

This should match the computer name that the certificate is deployed on, or be a wild card. This must match exactly the host used in the endpoints. For information on viewing the subject, see https://technet.microsoft.com/en-us/library/cc754686(v=ws.10).aspx.
3. Copy the thumbprint of the certificate. You use the thumbprint to bind the certificate to the port used by the primary NMS services in the next step.

For information on retrieving the thumbprint, see https://msdn.microsoft.com/en-us/library/ms734695.aspx.

4. Bind the SSL port (443) used by the services to the certificate.

   Windows Server 2008 or 2012:
   a. Open a command prompt.
   b. Using the netsh utility, run the following command to bind port 443 to the certificate:

      ```
      netsh http add sslcert ipport=0.0.0.0:443 certhash=<thumbprint> appid={00000000-0000-0000-0000-000000000000}
      ```

5. Verify that the UseSSL setting is set to true (this should have been done by the installer):
   a. In Nuance.NMS.Server.exe.config, located in the NMS Platform installation folder, find the line near the top that contains the key="UseSSL" tag.
   b. Change the value to true:

      ```
      <add key="UseSSL" value="true"/>
      ```

6. Bind the SSL certificate under IIS to port 443.
a. In the IIS Manager, from the left panel, click **Default Web Site**.
b. From the right panel, click **Bindings**....
   The Site Bindings dialog box opens.
c. Click **Add**.
   The Add Site Binding dialog box opens.
d. From the **Type** drop-down list, select **https**.
e. From the **SSL certificate** drop-down list, select the certificate that you installed.
f. Click **OK**.
   The Site Bindings dialog box appears. Ensure that the binding is displayed correctly.

7. Restart the NMS Platform server to allow any configuration changes to take effect.

### Install the SSL certificate—Installing on a load balancing switch

Nuance uses this mode in the Nuance data center when the NMC server is behind a load balancing switch that also decrypts SSL. In this scenario, the load balancing switch would strip the SSL encryption and forward the messages on to the appropriate NMC server. Inside the firewall, these messages would be unencrypted, and the NMC server would receive them as HTTP with no SSL encryption.

This should only be configured by experienced networking personnel. It requires in-depth knowledge about load-balancing switches, which is outside the scope of this guide.

1. Verify that **UseSSL** is set to false (this should have been done by the installer):
   a. In **Nuance.NMS.Server.exe.config**, located in the NMC Platform installation folder, find the line near the top that contains the key="UseSSL" tag.
   b. Change the value to false:
      
      ```
      <add key="UseSSL" value="false"/>
      ```
   2. Restart the NMC server to allow the configuration changes to take effect.

### Testing and troubleshooting your SSL configuration

Run these tests on a different computer. Do not run them on the NMC server.

#### Use the browser

1. Can you access and log into the NMC console?
   a. Connect to **https://<SERVER_NAME>/NMCHTML/**.
      
      If you see the Nuance Management Center login page, port 443 is working, and the NMC console is being deployed properly.
   b. Log in to the NMC console. If successful, the console is able to communicate with the server.

2. Can you access the NMC console status interface?
   1. Connect to **https://<SERVER_NAME>/NMS/Platform/ConfigurationSvc/v1/Status**.
      
      An XML response should appear in the browser.

3. Can you make RESTful web service calls?
Attempt to create an NMS session using the browser.


   A prompt for a login and password appears.

b. Use any valid NMC console login and password.

c. If some XML is returned, the NMC console is configured properly and working with SSL.

4. Can you access the NMS API Help pages?


   2. Enter any credentials if prompted.

   3. An HTML page with help for one of the NMS API sets should appear. If you see this help, the NMC server is configured and working properly.

Check the Bindings

If the NMC console is not working, make sure that the ports are properly bound to the SSL certificate. You can do this by using the "netsh http show sslcert" command to display the current configuration. Be sure that port 443 is bound to the certificate.
Verifying the NMS Platform service is running

When the installation completes, the NMS Platform service starts automatically if the Windows administrator account under which it is running has the correct privileges. Post-installation, you should verify that the service is running.

To verify, check the Services dialog box on the physical NMC server. If the service is not running, you must start it manually.

Starting the NMS Platform service manually

Before starting the service manually, verify that the Windows administrator account has the correct privileges. For more information, see “Server installation prerequisites” on page 11.

If the account has the correct privileges, do the following to start the service manually:

1. Open the Windows Control Panel.
2. Click Administrative Tools.
   The Services window opens.
4. Locate the NMS Platform service, and then right-click the service and select Properties.
   The NMS Platform Properties dialog box opens.
5. From the Startup type drop-down list, select Automatic.
6. Click the Start button to start the service.
7. Click OK.
   The dialog box closes.
Configuring your network switch

If you have multiple NMC servers in your environment, you can use a network traffic switch to balance the incoming client activity among your servers. You can configure the switch to make an API call periodically to your servers to ensure they are operational.

Configure the switch to make the following API call:

http://<NMS-Server-Name>:443/Nuance.NMS.Services/
    NMSServiceStatus/Rest/Status

If operational, the NMC servers return the following XML response:

<ServiceStatusResponse
     xmlns="http://schemas.datacontract.org/2004/07/Nuance.NAS.Connector.DictationTranscription"
     xmlns:i="http://www.w3.org/2001/XMLSchema-instance">
     <Status>Running</Status>
     <ServerDateTimeUTC>2010-12-13T20:50:13.0969590Z</ServerDateTimeUTC>
     <InterfaceType>basicHttpTransport</InterfaceType>
</ServiceStatusResponse>

If the servers are down, the switch receives an error. If the switch receives anything other than the expected response, the switch can tag a specific server as down and reroute network traffic.
Logging in to the Nuance Management Center (NMC) console

Ensure you can log in to the NMC console using the administrator login and password.

If you have multiple NMC servers in your environment and you are using a network traffic switch to balance the load, ensure you substitute the name or IP address of the switch for the NMC server name in the URL when you access the NMC console.

1. Open a browser.
2. Enter the NMC console URL in the address bar.
   
   You should have received this address in your welcome email from Nuance. The URL is in the format: https://<servername>/nmc/html
3. Enter the following information:
   
   **User Name**: admin
   
   **Password**: The password you specified for the administrator account during the installation.
4. Click **Login**.
   
   The NMC console opens.
Determining your database backup method

The NMC server schedules database backups automatically. However, you can choose to manage database backups yourself and disable the automatic backups. You should determine your database backup method before users begin regular Nuance Management Center use.

For more information on Nuance Management Center database backups, see “About database backups” on page 139.
Single sign-on overview

You can optionally implement Active Directory single sign-on authentication rather than using the native Nuance Management Center authentication, which requires a separate login and password. With single sign-on, users can simply use their Windows login and password to access the Dragon client and other applications.

Ideally, you should decide to use single sign-on before you install Dragon clients, as you can configure some of the required settings during the batch or push install. However, it is possible to enable single sign-on after client installation.

Both on-premise customers and customers using the Nuance-hosted cloud server can implement single sign-on.
Before you begin

Review the following before beginning your single sign-on configuration.

Software requirements—Single sign-on for Cloud NMC server

Cloud NMC server

If you are using the Nuance-hosted NMC server, you must install the Local Authenticator on a server with the following:

- Latest version of the Microsoft .NET Framework installed
- One of the following operating systems:
  - Microsoft® Windows Server 2008, Service Pack 1, Service Pack 2
  - Microsoft® Windows Server 2008 R2, 32-bit and 64-bit
  - Microsoft® Windows Server 2008 R2 64 bit Service Pack 2
  - Microsoft® Windows Server 2012
  - Microsoft® Windows Server 2012 R2 (64 bit)

In addition, you'll need the following:

- SSL certificate
  While Nuance Management Center supports self-signed certificates, Nuance strongly recommends that you use a certificate signed by a certificate authority. For more information, see “Installing and binding the SSL certificate” on page 45.

You can download the Local Authenticator installation file from the NMC console.

For information on which server to install the Local Authenticator, see “About the Local Authenticator” on page 42.

Other requirements

- When you create user accounts in the NMC console, each user's login must match that user's Windows Domain login exactly.
  For more information on creating user accounts, see the Nuance Management Center Administrator Guide.

Checklist—Planning the single sign-on setup

If you’re using single sign-on authentication, use these checklists to help you prepare for the configuration.

Cloud NMC server

If you're using the Nuance-hosted cloud NMC server, use this checklist to help you prepare for the configuration.

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Review software requirements</td>
<td>“Software requirements—Single sign-on for Cloud NMC server” on page 36</td>
</tr>
<tr>
<td>☐ Create an NMC console administrator account for Active Directory</td>
<td>”Creating an NMC console Administrator user for Active Directory” on page 38</td>
</tr>
<tr>
<td>Task</td>
<td>Reference</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set the Active Directory connection string</td>
<td>“Setting the Active Directory connection string” on page 39</td>
</tr>
<tr>
<td>Create and configure user accounts in the NMC console</td>
<td>“Creating and configuring user accounts for single sign-on” on page 40</td>
</tr>
<tr>
<td>Download the Local Authenticator</td>
<td>“Downloading the Local Authenticator” on page 43</td>
</tr>
<tr>
<td>Create an organization token</td>
<td>“Creating organization tokens” on page 44</td>
</tr>
<tr>
<td>Install and bind the SSL certificate on the Local Authenticator server</td>
<td>“Installing and binding the SSL certificate” on page 45</td>
</tr>
<tr>
<td>Install the Local Authenticator</td>
<td>“Installing the Local Authenticator” on page 50</td>
</tr>
<tr>
<td>Edit the Local Authenticator configuration file</td>
<td>“Editing the configuration file” on page 54</td>
</tr>
<tr>
<td>Start the Local Authenticator service</td>
<td>“Starting the Local Authenticator service” on page 55</td>
</tr>
<tr>
<td>Associate Dragon clients with the Local Authenticator</td>
<td>“Associating Dragon clients with the NMC server or Local Authenticator” on page 72</td>
</tr>
</tbody>
</table>

### On-premise NMC server

If you’re hosting your own NMC server on-premise, use this checklist to help you prepare for the configuration.

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an NMC console administrator account for Active Directory</td>
<td>“Creating an NMC console Administrator user for Active Directory” on page 38</td>
</tr>
<tr>
<td>Set the Active Directory connection string</td>
<td>“Setting the Active Directory connection string” on page 39</td>
</tr>
<tr>
<td>Create and configure user accounts in the NMC console</td>
<td>“Creating and configuring user accounts for single sign-on” on page 40</td>
</tr>
<tr>
<td>Associate Dragon clients with the NMC server</td>
<td>“Associating Dragon clients with the NMC server or Local Authenticator” on page 72</td>
</tr>
</tbody>
</table>
Creating an NMC console Administrator user for Active Directory

To configure Active Directory single sign-on and manage settings, you must create an Administrator user in the NMC console. You cannot use the initial NMC console login that Nuance provides (cloud NMC server), or the login that you create during the NMC console installation (on-premise NMC server). The Active Directory administrator login must match a login that exists in Active Directory.

1. Log in to the NMC console.
2. From the Menu bar, select User Accounts.
3. In the User Accounts ribbon, click the Add icon.
   The User Account Details window opens.
4. Configure the settings in the tabs:
   - **Details**—The highlighted text boxes indicate required data (First Name, Last Name and Login).
   - **Address**—Enter the user’s physical address.
   - **Group Memberships**—Add the Active Directory administrator to a Group.
   - **Messaging**: Configure email settings to enable the NMC console to send messages to users and administrators.
   - **Dragon Professional**—Configure user settings in the Dragon client.
     For now, you can skip this step. The default settings are applied. For more information, refer to “Configuring user settings” in the Nuance Management Center Administrator Guide.
   - **User Profile**—Ignore these settings. They are provided by the Dragon client.
5. Click Save.
   A dialog box appears, displaying the available licenses. If no administrator licenses are available, contact your Nuance representative.

After you have completed the steps above, log out of the NMC console, then log in using the NMC console administrator user account you created for the Active Directory administrator. You can now revoke the NMC console administrator license of the original admin user and grant that license to another user account.
Setting the Active Directory connection string

1. In the NMC console menu bar, click Sites, then click the Organization Overview icon. Click your organization, and then click the Details icon in the Organizations area.

   The Organization Details screen appears.

2. Click the Domains tab.

3. Click Add.

   The Domain dialog box appears.

4. Enter the following:

   Name—Your domain name. For example, ABCCompany.

   Active Directory connection strings—The Active Directory connection string. For example, LDAP://bn-ad04.

5. Click Save.

6. Repeat steps 3-5 as needed for each domain.

When Active Directory is enabled, Nuance Management Center sends all authentication requests to the server you specified in the Active directory connection strings field.
Creating and configuring user accounts for single sign-on

Creating user accounts

If you have not already created user accounts in the NMC console, you must create them before enabling single sign-on. When you create user accounts, each user’s login must match that user’s Windows domain login exactly.

On the User Account Details screen (click User Accounts in the menu bar, then click the Add icon), enter the user’s Windows domain login name in the Login field:

For example, enter “John_Doe” in the Login field if the user’s Windows domain login name is one of the following:

- “Domain\John_Doe”
- “John_Doe@domain.example.com”

Configuring user accounts

When you have created user accounts, do the following to add the users to your domain:

1. From the menu bar, click User Accounts.
2. Click Search to search for a user.
3. Specify search criteria, and then click Search.
   Search results appear.
4. Right-click a user, and then select User Account Details.
5. Click the Credentials tab.
6. Click the NTLM tab.
7. Click Add.
   The New NTLM Credential dialog box appears.
8. Select your domain from the Domain drop-down list.
9. Enter the user’s Windows domain login in the Login field.
10. Click Save.
# Chapter 7: Installing the Local Authenticator

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Local Authenticator</td>
<td>42</td>
</tr>
<tr>
<td>Local Authenticator logs</td>
<td>42</td>
</tr>
<tr>
<td>Downloading the Local Authenticator</td>
<td>43</td>
</tr>
<tr>
<td>Creating organization tokens</td>
<td>44</td>
</tr>
<tr>
<td>Installing and binding the SSL certificate</td>
<td>45</td>
</tr>
<tr>
<td>About certificates</td>
<td>45</td>
</tr>
<tr>
<td>Install the SSL certificate</td>
<td>45</td>
</tr>
<tr>
<td>Testing and troubleshooting your SSL configuration</td>
<td>48</td>
</tr>
<tr>
<td>Installing the Local Authenticator</td>
<td>50</td>
</tr>
<tr>
<td>Editing the configuration file</td>
<td>54</td>
</tr>
<tr>
<td>Starting the Local Authenticator service</td>
<td>55</td>
</tr>
</tbody>
</table>
About the Local Authenticator

The Local Authenticator is a service that provides Dragon clients with Active Directory single sign-on authentication. The Local Authenticator validates Dragon client credentials when the clients attempt to connect to the Nuance-hosted cloud NMC server, and then passes the validate credential call to the cloud NMC server to create a session.

You must install the Local Authenticator to use single sign-on with the Nuance-hosted cloud NMC server. You do not need the Local Authenticator if you’re hosting your own NMC server on-premise.

Install the Local Authenticator on a local server that is accessible to both the NMC server and your Dragon clients. You must have Administrator privileges on the server where you are installing the Local Authenticator.

For software system requirements for the Local Authenticator, see “Software requirements—Single sign-on for Cloud NMC server” on page 36.

Local Authenticator logs

The Local Authenticator uses the same service trace logs as Nuance Management Center. These logs can be found in:

C:\ProgramData\NMS\Logs
Chapter 7: Installing the Local Authenticator

Downloading the Local Authenticator

You can download the LocalAuthenticator.exe file from your NMC console. You then install the Local Authenticator on a local server that is accessible to both NMC server and your Dragon clients.

To download the Local Authenticator:

1. Log in to your NMC console as an Administrator.
2. In the Utilities ribbon, click Tools.
   The Tools page appears.
3. Click Install local authenticator.
   A message appears, prompting you to save or run the Local Authenticator executable.
4. Click Save.
   The LocalAuthenticator.exe file is saved to your local Downloads folder.
5. Copy the LocalAuthenticator.exe file to the local server on which you are installing it.
Creating organization tokens

The Local Authenticator installation requires an organization token. You create a token in the NMC console.

To create an organization token:

1. From the menu bar, select Sites > Organization Overview.
2. Right-click your organization, and then select Details.
   The Organization Details page appears.
3. Click the Organization Token tab.
4. Click Add to generate a new organization token.
   The Organization Token Info dialog box appears. The Organization Token field is pre-populated with a system-generated token.
5. Optionally, enter a value in the Comment field.
6. Write down the token number.
   You must enter this number during the Local Authenticator installation.
7. Click Save.
   The new token appears in the Organization Token table.
Installing and binding the SSL certificate

About certificates

Using SSL requires that you obtain an SSL certificate. Nuance Management Center supports both signed certificates from a certificate authority, and self-signed (or internally generated) certificates. However, Nuance strongly recommends that you use a signed certificate, as self-signed certificates are not always easily recognized by the client the same way signed certificates are.

You can obtain signed certificates from certificate authorities, such as GoDaddy or Verisign. The certificate authority must be a trusted authority known to both the client computer and the server.

To obtain a signed certificate, you'll need to provide information to the certificate authority about your organization and the server on which you are installing the certificate in the Certificate Signing Request (CSR). Each certificate authority may require different information. Typically, the information can include the following:

- Organization name
- Organization location information, such as town and state
- Computer name for the server on which you are installing the certificate
- Extended Key Usage value, such as 2.5.29.37. Extended key usage further refines key usage extensions, which define the purpose of the public key contained in the certificate.
- Key Size, such as 2048 bits or 4096 bits. Determines the length of the public key in the certificate. A longer key provides stronger security. You determine the level of security that is appropriate for your environment.

You obtain this information from your IT department, or from the person who installed and configured your server.

For more detailed information on installing SSL certificates, see:


Install the SSL certificate

Clients contact the Local Authenticator on the standard HTTP ports 80 and 443.

1. Install an SSL certificate in the Personal Store under the Local Computer section for the "logon as" user account under which the NMS service is running.

   To add the Certificates Snap-in and view the certificates installed on the local computer, see https://technet.microsoft.com/en-us/library/cc754431(v=ws.11).aspx.
2. Note the subject of the certificate.

This should match the computer name that the certificate is deployed on, or be a wild card. This must match exactly the host used in the endpoints. For information on viewing the subject, see https://technet.microsoft.com/en-us/library/cc754686(v=ws.10).aspx.
3. Copy the thumbprint of the certificate. You use the thumbprint to bind the certificate to the port used by the primary NMS services in the next step.

For information on retrieving the thumbprint, see https://msdn.microsoft.com/en-us/library/ms734695.aspx.

4. Bind the SSL port (443) used by the services to the certificate.

**Windows Server 2008 or 2012:**

a. Open a Command prompt.

b. Using the netsh utility, run the following command to bind port 443 to the certificate:

```
netsh http add sslcert ipport=0.0.0.0:443 certhash=<thumbprint> appid={00000000-0000-0000-0000-000000000000}
```

5. Verify that the UseSSL setting is set to true (this should have been done by the installer):

a. In Nuance.NMS.Server.exe.config, located in the NMS Platform installation folder, find the line near the top that contains the key="UseSSL" tag.

b. Change the value to true:

```
<add key="UseSSL" value="true"/>
```

6. Bind the SSL certificate under IIS to port 443.
a. In the IIS Manager, from the left panel, click **Default Web Site**.
b. From the right panel, click **Bindings**...
The Site Bindings dialog box opens.
c. Click **Add**.
The Add Site Binding dialog box opens.
d. From the **Type** drop-down list, select **https**.
e. From the **SSL certificate** drop-down list, select the certificate that you installed.
f. Click **OK**.
The Site Bindings dialog box appears. Ensure that the binding is displayed correctly.

7. Restart the Local Authenticator server to allow any configuration changes to take effect.

**Testing and troubleshooting your SSL configuration**

**Run these tests on a different computer. Do not run them on the Local Authenticator server.**

**Use the browser**

1. Can you access and log into the NMC console?
   a. Connect to https://<SERVER_NAME>/NMCHTML/.
      If you see the Nuance Management Center login page, port 443 is working, and the NMC console is being deployed properly.
   b. Log in to the NMC console. If successful, the console is able to communicate with the server.

2. Can you access the NMC console status interface?
      An XML response should appear in the browser.

3. Can you make RESTful web service calls?
   Attempt to create an NMS session using the browser.
      A prompt for a login and password appears.
   b. Use any valid NMC console login and password.
   c. If some XML is returned, the NMC console is configured properly and working with SSL.

4. Can you access the NMS API Help pages?
   b. Enter any credentials if prompted.
   c. An HTML page with help for one of the NMS API sets should appear. If you see this help, the NMS is configured and working properly.
Check the Bindings

If the NMC console is not working, ensure that the ports are properly bound to the SSL certificate. You can do this by using the "netsh http show sslcert" command to display the current configuration. Be sure that port 443 is bound to the certificate.
Installing the Local Authenticator

On the server where you are installing the Local Authenticator:

1. Run the LocalAuthenticator.exe file.
   A dialog box appears, prompting you to select a language for the installation.
2. Select your language from the drop-down list, and then click OK.

   ![Image of InstallShield Wizard]

   The InstallShield Wizard opens.
3. Click Next.
4. Leave the default value in the **User Name** field and enter your company name in the **Company** field. Then, click **Next**.

5. Set the location where the Local Authenticator will be installed, and then click **Next**.
6. In the **Token** field, enter the organization token that you generated in the NMC console, and then click **Next**.
7. Click **Install**.
   A status dialog appears.

![Local Authenticator - InstallShield Wizard](image)

Click Install to begin the installation.
If you want to review or change any of your installation settings, click Back. Click Cancel to exit the wizard.

8. When the installation is complete, the InstallShield Wizard Complete dialog appears. Click **Finish** to exit the installer.

![Local Authenticator - InstallShield Wizard](image)

InstallShield Wizard Complete
The InstallShield Wizard has successfully installed Local Authenticator. Click Finish to exit the wizard.
Editing the configuration file

You edit the Local Authenticator configuration file to change the NMC server address to the appropriate address. You should have received this address in your welcome information from Nuance.

1. Open the folder where the Local Authenticator is installed. By default, the Local Authenticator is installed in:

   C:\Program Files\Nuance\Local Authenticator

2. In any text editor, open NMS.LocalAuthenticator.Service.exe.config.
   
   This is the Local Authenticator configuration file.

3. Find the line "<add key="NMSServerAddress" value="<NMS in the Cloud>"/>" and change the value to the address of your NMC server.

4. Save your changes.
Starting the Local Authenticator service

1. Open the Server Manager to view your Windows services.
2. Look for the **NMS Local Authenticator Service**.
3. Right-click the service, and then select **Start**.
Chapter 8: Preparing for your Dragon Group client installation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software and hardware requirements—Client</td>
<td>57</td>
</tr>
<tr>
<td>Dragon Group hardware recommendations</td>
<td>57</td>
</tr>
<tr>
<td>Supported Virtual Desktop infrastructure applications</td>
<td>58</td>
</tr>
<tr>
<td>Required skills for installing Dragon Group</td>
<td>59</td>
</tr>
<tr>
<td>Dragon File Structure</td>
<td>60</td>
</tr>
<tr>
<td>Windows 7, Windows 8.x, and Windows 10</td>
<td>60</td>
</tr>
<tr>
<td>Accessing program files</td>
<td>61</td>
</tr>
<tr>
<td>Assigning access</td>
<td>62</td>
</tr>
<tr>
<td>Assigning permissions</td>
<td>62</td>
</tr>
<tr>
<td>Configuring client workstations</td>
<td>63</td>
</tr>
<tr>
<td>Turning off Windows Automatic Updates</td>
<td>63</td>
</tr>
<tr>
<td>Anti-virus recommendations</td>
<td>63</td>
</tr>
<tr>
<td>Recommended virtual memory settings</td>
<td>63</td>
</tr>
</tbody>
</table>
Software and hardware requirements—Client

Dragon Group hardware recommendations

The Dragon Group installer verifies that your system meets the minimum requirements. If the minimum requirements are not met, the client is not installed.

Supported operating systems

- Microsoft Windows 10, 32-bit and 64-bit
- Microsoft Windows 8.1, 32-bit and 64-bit
- Microsoft Windows 8 (including Professional and Enterprise), 32-bit and 64-bit
- Microsoft Windows 7, 32-bit and 64-bit
- Microsoft Windows Server 2008 R2
- Microsoft Windows Server 2012 (64-bit only)

RAM

Minimum 2 GB for the 32-bit versions of Microsoft Windows 7, Windows 8, Windows 8.1, and Windows 10
Minimum 4 GB for all other supported operating systems

CPU

Minimum 2.2 GHz Intel® dual core or equivalent AMD processor

Faster processors yield faster performance.

Free hard disk space

4 GB (8 GB recommended)

Audio devices

- A sound card supporting 16-bit recording
- A Nuance-approved microphone: headset microphone (USB or not), Bluetooth microphone (Enhanced/wideband works best), or user-facing built-in laptop microphone (single or multiple element) (See http://support.nuance.com/compatibility/)
- If you’re using Dragon to transcribe recordings: a voice recorder or smartphone app supporting one of these formats: .mp3, .m4a, .wav, .wma, .ds2 or .ds2

Other requirements

- Internet Explorer 9 or higher, or the current version of Chrome or Firefox, for online Help
- A DVD-ROM drive for initial installation
- An Internet connection to automatically activate the software (a quick anonymous process) and, if you purchased the Dragon web installer instead of a DVD, to install the software
Supported Virtual Desktop infrastructure applications

- XenDesktop 7.6
- XenApp 7.6
Required skills for installing Dragon Group

To install the Dragon Group software, you should be able to:

- Set Windows user rights and directory permissions
- Edit XML configuration files
Chapter 8: Preparing for your Dragon Group client installation

Dragon File Structure

During installation, Dragon sets up the following default folders for application and data storage.

Upgrading Dragon from an earlier version automatically relocates some directories and files.

Windows 7, Windows 8.x, and Windows 10

**Dragon setup log (dgnsetup.log)**

C:\ProgramData\Nuance\NaturallySpeaking14\logs

**Dragon log**

C:\ProgramData\Nuance\NaturallySpeaking14\logs\<Windows_User_Name>

**User profiles**

C:\ProgramData\Nuance\NaturallySpeaking14\Users

**Upgrade log**

C:\Users\<Windows_User_Name>\AppData\Roaming\Nuance\NaturallySpeaking14

**Local Roaming user profiles**

C:\ProgramData\Nuance\NaturallySpeaking14\RoamingUsers

**Vocabularies and Acoustic Models**

C:\ProgramData\Nuance\NaturallySpeaking14\Data

**Custom words and commands**

C:\ProgramData\Nuance\NaturallySpeaking14\custom\<language>\n
**Program files**

<table>
<thead>
<tr>
<th>For 32-bit systems</th>
<th>For 64-bit systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Program Files\Nuance\NaturallySpeaking14\Program</td>
<td>C:\Program Files (x86)\Nuance\NaturallySpeaking14\Program</td>
</tr>
</tbody>
</table>

**Help**

<table>
<thead>
<tr>
<th>For 32-bit systems</th>
<th>For 64-bit systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Program Files\Nuance\NaturallySpeaking14\Help</td>
<td>C:\Program Files (x86)\Nuance\NaturallySpeaking14\Help</td>
</tr>
</tbody>
</table>

**Interactive Tutorial**

<table>
<thead>
<tr>
<th>For 32-bit systems</th>
<th>For 64-bit systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Program Files\Nuance\NaturallySpeaking14\tutorial</td>
<td>C:\Program Files (x86)\Nuance\NaturallySpeaking14\tutorial</td>
</tr>
</tbody>
</table>
Accessing program files

The Dragon client and many associated utilities can be accessed through the Start menu. Their location varies by operating system:

- Windows 7: Select Start > All Programs > Dragon.
  - Some utilities are located inside the Dragon Tools subfolder.
- Windows 8.x: From the Start screen, click the down arrow to show all applications. Scroll to find Dragon.
- Windows 10: Select Start > All apps > Dragon.
Assigning access

To ensure that your Dragon Group network components can communicate with each other and that the network can function properly, you must assign permissions to all appropriate directories and access rights to administrator and user accounts on servers and clients as indicated below.

<table>
<thead>
<tr>
<th>Location or registry key</th>
<th>Permissions level or type of access rights</th>
<th>Users affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roaming user profiles folder</td>
<td>Full read/write/modify permissions</td>
<td>Windows user accounts for all end-users dictating on Dragon Clients</td>
</tr>
<tr>
<td>C:\ProgramData\Nuance folder and all sub-folders</td>
<td>Full read/write/modify permissions</td>
<td>Windows user accounts for all end-users dictating on Dragon Clients</td>
</tr>
<tr>
<td>C:\Users&lt;Windows User ID&gt;\AppData\ folder and all sub-folders</td>
<td>Full read/write/modify permissions</td>
<td>Windows user accounts for all end-users dictating on Dragon Clients</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Nuance</td>
<td>Rights to update the registry to read/write to these keys</td>
<td>Windows accounts used on workstations running the Dragon client</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER\SOFTWARE\Nuance</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Assigning permissions

Clients

To ensure every dictating user has appropriate access to his or her user profile, you must give full read/write/modify permissions to all files and directories housing the Roaming user profiles, even through http or https connections. This level of permission/access ensures that when the user dictates, Dragon can interact with the Roaming user profiles effectively.

Each Windows user account that logs in to the Dragon client workstation should also have read/write/modify access to the Roaming user profiles, since the Dragon client frequently modifies these profiles.

Roaming user profiles

Be sure that when you set up the Roaming user profiles directory, you locate it either on a Windows machine or on a device connected to a Windows machine with .NET Framework 4.0 installed on it.

In Nuance Management Center 5.0, the NMC server supports deployments on standard ports (443/80). The NMC server examines the standard ports to see if they are available. If they are not, it defaults back to the normal custom ports (8051 and 8731).
Configuring client workstations

Turning off Windows Automatic Updates

After you set up each physical server or workstation, be sure to turn off Windows Automatic Updates. For each update Windows sends, install it first on a single test machine; update other machines only after you have determined that it does not disrupt the network.

Anti-virus recommendations

Nuance recommends anti-virus software be installed on all Dragon servers and clients. For information on files and folders to exclude from anti-virus protection, see "Excluding files and folders from anti-virus protection" on page 12.

Recommended virtual memory settings

Nuance recommends that you set virtual memory to the following levels.

Server Virtual Memory
Set to three times the physically installed RAM.

Workstation Virtual Memory
Set Virtual Memory to 4092, or to the maximum possible setting on workstations that have 4 GB of RAM.
Chapter 9: Installing the Dragon Group client
Chapter 10: Installing the Dragon client with Settings

Overview—Installing the Dragon client with initial settings ................................................. 66
  Prerequisites .................................................................................................................. 66
  Push installations .......................................................................................................... 66
  Support for SMS and Windows Server with Active Directory ........................................... 67
Installing the same Dragon configuration on multiple computers ........................................ 68
Performing an administrative installation with a batch file ................................................ 69
  Understanding the script in admininstall.bat .............................................................. 69
  Modifying admininstall.bat ........................................................................................... 69
Command Line installation with msiexec.exe ...................................................................... 70
  Installing the same configuration on additional computer(s) ....................................... 70
Overview—Installing the Dragon client with initial settings

You can use command line options to copy your initial Dragon settings to all your Dragon client installations.

Prerequisites

Before installing the Dragon client, do the following:

- Have the Dragon serial number available. If you are installing or upgrading Dragon on multiple networked computers, have the group serial number available.
- Ensure all mapped drives you plan to use are mapped on each client computer where you are distributing the installation.
- Install any pending Windows updates on clients and restart as needed.
- Copy any .ini files you want apply to your installation to a central location so you can access them later.

- If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you must also install Microsoft Search before installing Dragon.
- Enclose long path names containing spaces in quotation marks. Be sure to escape the each quotation mark with a backslash: \\
- You can use the /qn option to install the product in Quiet mode, where there is no user interface, and no messages appear. To use the /qn option, add it to the end of the command line. Another option, the /passive mode, runs the entire installation unattended, but displays a progress bar.
- The first time you run an installation from the command line, you should use the /qf option rather than /qn. This allows you to see prompts that help you determine any problems with the command line.
- To ensure that you receive messages about any errors that occur during the installation, pass /L and one or more sub-options, followed by a log file name. The installer then creates a file containing any installation log errors and other messages related to the process. You can send the log file to technical support, should any issues arise.

Push installations

Dragon includes a native Windows Installer (MSI) that allows you to install across a network to multiple client computers and customize your installations. You can use the included Dragon 14.msi (see “Command Line installation with msiexec.exe” on page 70) or admininstall.bat file (see “Performing an administrative installation with a batch file” on page 69).

Several servers support this type of network installation:

- Windows Server 2008 R2 and 2012 x64
- System Management Server (SMS)
- Active Directory
For an administrative installation, the administrator creates an image of the installation program on the server and then configures the server to automatically push the application onto the client systems. You can also configure network installations to modify, repair, or remove an existing installation.

**Support for SMS and Windows Server with Active Directory**

Systems Management Server (SMS) provides a mechanism for pushing application installations out from the server to client systems. SMS supports using the Windows Installer (MSI) to push installations on clients using Windows 7, 8 or 10. SMS requires that a client application be installed on all client computers.

Active Directory is a feature of Windows Server 2008 and 2012. The Group Policy component of Active Directory includes a Software Installation snap-in that lets an administrator create a network installation. Administrators can use this feature to install software onto Windows 7, 8 and 10 clients.

Dragon supports the Active Directory Assign to Computers installation option. This option successfully installs the software when the computer is restarted. Administrators can delay installation on Windows clients by enabling logon optimization for group policy; for this type of installation, you can view an entry for the installation in the event log after the first restart. The installation is then performed on the second restart. The installation takes place silently, and the software is installed for all users on the computer. When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the setup log.
Installing the same Dragon configuration on multiple computers

Do the following to install with setup.exe in the command line from a single client machine. To use Dragon 14.msi instead, see “Command Line installation with msiexec.exe” on page 70.

1. Open a Command Prompt:
   - Windows 7: Start > All Programs > Accessories > Command Prompt
   - Windows 8.x: From the Start screen, click the down arrow to show all apps > scroll to Windows System > Command Prompt
   - Windows 10: Start > All apps > Windows System > Command Prompt

2. Insert the installation DVD and search for the directory where setup.exe is located.

3. In the Command Prompt window, switch to the setup.exe directory.

4. To install the configuration you created during the initial installation, enter the following. Pass your Dragon serial number for the SERIALNUMBER option and the full path to your customized nsdefaults.ini file to the DEFAULTSINI option:

   ```
   setup.exe /s /v"SERIALNUMBER=#####-####-####-####-
   INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
   DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
   /L*v C:\Logs\logfile.log"
   ```

   **Stand-Alone mode:** To include Roaming user profile settings in your installation, see “Installing a Roaming user profile configuration on additional computers” on page 137.

5. When you are using the setup.exe method, you must ensure that all flags and properties are within the same set of quotes, directly after /v, without a space.

6. Enclose long path names containing spaces in quotation marks. Be sure to escape the each quotation mark with a backslash: " ".

7. See “MSI options for Dragon installations” on page 118 for details on the MSI options available for Dragon installations.
Performing an administrative installation with a batch file

A simple way to install Dragon from the command line is to perform an administrative installation using a .bat file. A script for performing a full administrative installation is provided in the admininstall.bat file on the DVD.

Only advanced administrators should perform an administrative installation.

To run the batch file, open a Command Prompt and enter admininstall.bat and follow it with the location of Dragon 14.msi.

Understanding the script in admininstall.bat

Below are some of the lines from the script in the admininstall.bat file, a batch file that decompresses setup files into a network location for installation using SMS or another service.

Near the top of the batch file are the lines that check the parameters entered and, if the parameter passed is not acceptable, execute a routine that handles that situation:

```batch
:rem //Check and analyze input parameters
if .%1==. goto bad_args
```

If the arguments you pass when you enter the command are acceptable, the batch file sets the NETWORK_DNS_DIR to the location of Dragon 14.msi:

```batch
set NETWORK_DNS_DIR=%1%
```

When you run the admininstall.bat file, the file installs Dragon using a single line of code:

```batch
echo Installing Dragon...
setup.exe /a /s /v"/qb TARGETDIR=%NETWORK_DNS_DIR% /L=!wmo!e+ %TEMP%\admininstall.log"
```

The above code calls the setup.exe command and passes it:

- `/a` - Indicates an administrative installation.
- `/s` - Indicates a silent installation.
- `/v` - Indicates msiexec options to follow, enclosed in quotation marks. The included options are:
  - `/qb` - Indicates a basic user interface display during the installation process.
  - TARGETDIR - Indicates the target directory for an administrative installation.
  - `/L` - Indicates the type of data that should be included in the log and where the log is saved.

When the installation of Dragon succeeds or fails, the batch file displays an appropriate message. The remainder of the file handles errors and cases where bad arguments are passed on the command line.

Modifying admininstall.bat

The admininstall.bat script includes a small subset of the options available. You can modify the file by adding to and changing the options you pass for installing Dragon. See "MSI options for Dragon installations" on page 118 for details on the MSI options available for Dragon installations.
Command Line installation with msiexec.exe

Another way to install Dragon from the command line on several client computers is to use the msiexec.exe program from Microsoft. You are required to use msiexec.exe instead of setup.exe if you are installing Dragon from a server across a network.

The compiled MSI file, Dragon 14.msi, is located on your installation DVD.

You can double-click on the .msi file to start the InstallShield Wizard. However, to take advantage of available command line options, you can pass the file name to the msiexec.exe command as the application to install by using the /i option:

msiexec.exe /i "Dragon 14.msi"

Installing the same configuration on additional computer(s)

1. Open a Command Prompt:
   - Windows 7: Start > All Programs > Accessories > Command Prompt
   - Windows 8.x: From the Start screen, click the down arrow to show all apps > scroll to Windows System > Command Prompt
   - Windows 10: Start > All apps > Windows System > Command Prompt

2. On your installation DVD, locate Dragon 14.msi and switch to that directory.

3. Retrieve the customized nsdefaults.ini file from the computer where you performed the initial installation.

4. To install Dragon, enter the following:

   msiexec /i "Dragon 14.msi"
   SERIALNUMBER=#####-####-####-####-####
   DEFAULTSINI="<full_path>\nsdefaults.ini"
   /L*v "C:\Logs\logfile.log" /qn

- For an administrative installation, pass the /a option to msiexec rather than the /i option. You also need to pass the TARGETDIR option instead of the INSTALLDIR option.
- Dragon setup is designed so that msiexec.exe can be run from an elevated command prompt in Windows. See “Windows elevated command prompts” on page 1 for instructions on opening an elevated command prompt in Windows 7, Windows 8 and Windows 10.
- See “MSI options for Dragon installations” on page 118 for details on the MSI options available for Dragon installations.
Chapter 11: Configuring the Dragon client for NMS

- Associating Dragon clients with the NMC server or Local Authenticator .................................. 72
- Converting from Stand-Alone to NMS mode .............................................................................. 73
Associating Dragon clients with the NMC server or Local Authenticator

To set up Dragon clients to work with NMS:

1. From the DragonBar, click Tools > Administrative Settings.

   You can also access the Administrative Settings dialog using the natspeak.exe command line options (see “Natspeak.exe Command Line Options” on page 1).

2. If a warning dialog appears, click Proceed to close all user profiles and open the Administrative Settings dialog.

3. Click the NMS Settings tab.

4. Select the Enable NMS check box if it is not already selected.

5. In the Server field, enter one of the following:

   - If you are using the Nuance-hosted cloud NMC server with native Nuance Management Center authentication, enter the address of the cloud NMC server. You should have received this address in your Welcome email from Nuance.
   
   - If you are using the Nuance-hosted cloud NMC server with Active Directory single sign-on authentication, enter the address of the server on which the Local Authenticator is installed.
   
   - If you are using your own NMC server on-premise, enter the address of your NMC server.

6. Click the appropriate radio button in the Login Options field.

   - Select Provide a login name and password if you are using native Nuance Management Center authentication.
   
   - Select Use Windows single sign-on if you configured your users for Active Directory single sign-on authentication.

7. Click Apply, and then click OK.

When the Dragon client is connected to the NMC server, users can log in to the user account that an administrator has created in the NMC console.

If the user has no existing profile, the New User Wizard appears after login.

For more information on setting up a new user profile, see “Working with user profiles” on the Dragon Help site.
Convert from Stand-Alone to NMS mode

If your organization decides to purchase Nuance Management Center after configuring Dragon for Stand-Alone use, you must configure all Dragon Group clients to connect to Nuance Management Center. Use one of the methods below to convert your clients.

These methods require modifying the default Dragon settings in `nsdefaults.ini`, the settings file you created when you configured default options in “Initial Installation—Dragon InstallShield wizard method” on page 1.

**Option 1**

Create a revised `nsdefaults.ini` file to enable NMS mode and provide the server address.

1. Add the following lines to a master copy of `nsdefaults.ini` under `[nssystem.ini Settings]`:
   ```
   Connect to NMS=1
   Default NAS Address=<server address>
   ```
   If you prefer, you can use `natspeak.exe` to add these parameters through the NMS Settings tab of the Administrative Settings dialog box. For more information, see “Natspeak.exe Command Line Options” on page 1.

2. Replace the `nsdefaults.ini` file in `C:\ProgramData\Nuance\NaturallySpeaking14` on all client computers with the edited master copy.

**Caution:** Replacing `nsdefaults.ini` on client machines will cause users to lose all their existing Auto-Formatting, Options, and Administrative settings.

**Option 2**

To avoid overwriting user settings, you can manually modify the settings on each client computer. Choose one of the following methods:

- Repeat step 1 above for the `nsdefaults.ini` file in the directory `C:\ProgramData\Nuance\NaturallySpeaking14` on each client computer.
- Manually configure the settings in the NMS Settings tab of the Administrative Settings dialog box. See the Dragon Group help for more online information.

Because this method requires visiting each computer, it is not recommended for larger organizations.
Chapter 12: Scheduling Optimization Tasks

Using Acoustic and Language Model Optimizer and Scheduler tools ............................................. 75
Checking the optimization status of a user profile ................................................................................. 75
Running the Acoustic and Language Model Optimizers from the DragonBar ..................................... 75
Running the Acoustic and Language Model Optimizer from the Start menu ................................. 76
Using Acoustic and Language Model Optimizer and Scheduler tools

Run the Acoustic and Language Model Optimizer Scheduler to:

- Optimize the acoustic files for a user profile.
- Optimize the language model for a user profile.
- Schedule one or both types of optimization to occur on a particular day or time at particular intervals.
- Enable or disable the scheduled optimizations.

Checking the optimization status of a user profile

Dragon Group checks the optimization status of a user profile when it is loaded if:

- The profile has never been loaded before.
- The “Learn from specific documents” and “Learn from sent e-mails” wizards have not run within one week of the profile’s creation.
- The “Learn from...” wizards have not run for six months.
- The Language Model Optimizer has not run in over two months.
- The Acoustic Optimizer has never run and at least one hour of recorded dictation is available.

Keeping custom words up-to-date

Using Dragon’s support for custom words, especially contact names, can make dictating with Dragon faster and more precise.

When Dragon loads a user profile, Dragon examines how long it has been since the last time custom words were updated. Dragon displays the Personalize Your Vocabulary dialog box when:

- The “Learn from...” wizards have not run within two days of creating a new profile.
- The “Learn from...” wizards have not run for one month or more. If the user dismisses the Personalize Your Vocabulary dialog, Dragon displays the dialog once a week until the wizards are run.

The Personalize Your Vocabulary dialog box contains information about the last time the “Learn from specific documents” and “Learn from sent e-mails” wizards ran for the profile. Users can run these wizards from the dialog box. The dialog box also displays the total time required to run the wizards.

Checking for user profile maintenance when saving a user profile

When a user saves a user profile or closes Dragon, Dragon checks that scheduled user profile maintenance has been performed recently. If not, an additional check box appears on the Save dialog box. The maintenance should only take an extra minute or two to complete and is always beneficial – especially when you have added new custom words.

Running the Acoustic and Language Model Optimizers from the DragonBar

If a user profile is open in the Dragon client, you can run the Acoustic and Language Model Optimizer from the DragonBar (Non-Roaming profiles only):

1. Select Audio > Launch Accuracy Tuning.
2. If the user has not dictated and corrected recognized text since the last time the optimizer was run, a message indicates that the Acoustic Optimizer does not need to be run. Click OK. The Acoustic
and Language Model Optimizer opens with the Perform Acoustic Optimization option unavailable.

3. Click Go to start. The process may take some time to complete.

4. A message appears when the process has completed. Click Done.

**Running the Acoustic and Language Model Optimizer from the Start menu**

You can also run the Acoustic and Language Model Optimizer from the Windows Start menu without opening a user profile:

- Windows 7: Select Start > All Programs > Dragon > Dragon Tools > Acoustic and Language Model Optimizer Scheduler.
- Windows 8.x: From the Start screen click the down arrow to show all applications. Scroll to find Dragon, then find Acoustic and Language Model Optimizer Scheduler.
- Windows 10: Select Start > All apps > Dragon > Acoustic and Language Model Optimizer Scheduler.

- Only an administrator can run the Acoustic and Language Model Optimizer from the Start menu.
- For Roaming user profiles, the system administrator is responsible for running the Acoustic and Language Model Optimizer on the network location of the Master Roaming user profiles. You can install Dragon on the computer where the Master Roaming user profiles are located or on any computer that has network access to the Master Roaming user profiles, then run the Scheduler. Later, any optimizations that result from running these tools are copied to the Local Roaming user profile when Dragon synchronizes it with the Master Roaming user profile.
- To optimize a Roaming user profile locally, disable Roaming and browse to the Master Roaming user profile location. You can now run the Acoustic and Language Model Optimizer as you would for a non-Roaming user profile.

1. The Acoustic and Language Model Optimizer opens, displaying a list of the user profiles stored in the default directory. To access a different directory, select File > Set User Directory.

The Set a Directory Containing User Files dialog box opens.

2. Enter the path to the directory, or click the Browse button and browse to the location of the user profiles or (for Roaming users only) Master Roaming user profiles, and then click OK.

   If the user profiles you want to optimize are located in multiple directories, you can later repeat these steps and change this directory to locate the additional user profiles.


4. The Windows user name and password dialog box opens. Enter your Windows user name and password, and then click OK.

   If you are logged in to a domain, you must insert the domain name in front of your user name.

The Select Frequency dialog box opens.
5. Under Optimization, select **Perform Acoustic Optimization**, **Perform Language Model Optimization**, or both.

6. Under **User Profile Information**, select a user profile from the **User Name** drop-down list or, to select multiple user profiles, click the **Multiple Users** button to open the **Select user profiles** dialog box.
   - Use the **Add** and **Remove** buttons to move selected user profiles to the **Selected end-users in this task** list on the right. You can also click **Add All** to add all profiles in the selected directory, or **Remove All** to remove all user profiles from the list.
   - You change the order of the list by selecting a name and clicking the **Move Up** or **Move Down** button. When you are satisfied with the list, click **OK** to proceed.

7. If you are running the Optimizer tasks for a single user:
   - In the **Dictation Source** text box, select an audio input device from the drop-down list.
   - In the **Vocabulary** text box, select a vocabulary from the drop-down list.

8. Under **Select Frequency and Start Date & Time**, select how often and at what time you want the optimization to run, and the first date it should run.

9. At the bottom of the dialog, click the **Enabled (schedule task runs at specified time)** check box to enable the optimization.

10. Click **Apply**.

11. Click **OK**.

   The **Acoustic and Language Model Optimizer Scheduler** dialog box displays a list of the events scheduled in the right pane. You can create more than one optimization schedule for a single user profile. When you do, both optimization events appear in the schedule list.

12. Click **File > Exit**.
Chapter 13: Working with Custom Commands

Using the Convert XML to DAT Tool ................................................................. 79
Starting the Convert XML to DAT tool ......................................................... 79
Convert XML to DAT syntax ........................................................................... 79
Use the XML to DAT tool to convert data in an XML file ........................... 79
Using the MyCommands Protection Utility ................................................... 80
Using the Convert XML to DAT Tool

You can use a text editor to edit custom commands in XML format. To restrict access to only Dragon users, you can convert your commands from XML format to DAT format. Dragon uses .dat files to store commands.

For more information on creating custom commands, see “Creating and editing custom commands” on the Dragon Help site. For help with Structured Commands, see the Advanced Scripting Reference.

You can use the XML to DAT tool (mycmdsxml2dat.exe) to extract user-defined Dragon commands from an XML file. The tool writes the commands to a .dat file.

Starting the Convert XML to DAT tool

- Windows 7: Click Start > All Programs > Dragon > Dragon Tools > Convert XML to DAT.
- Windows 8.x: From the Start screen, click the down arrow to show all applications. Scroll to find Dragon, then find Convert XML to DAT.
- Windows 10: Click Start > All apps. Scroll to find Dragon, then find Convert XML to DAT.

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool’s syntax.

Convert XML to DAT syntax

The convert XML to DAT tool (mycmdsxml2dat.exe) uses the following syntax:

mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;dat-file-path&gt;</td>
<td>Required</td>
<td>The full path to the local copy of the current end-user’s .DAT file (by default, C:\ProgramData\Nuance\NaturallySpeaking14\Data\enx\dat).</td>
</tr>
<tr>
<td>&lt;xml-file-path&gt;</td>
<td>Required</td>
<td>The full path to the .XML file to be converted.</td>
</tr>
<tr>
<td>-v</td>
<td>Optional</td>
<td>Validates the specified .xml file over the Internet with a Nuance DTD (Document Type Definition) file. Disabled by default.</td>
</tr>
</tbody>
</table>

Use the XML to DAT tool to convert data in an XML file

1. Create an XML file that contains the commands to use with Dragon.
2. On a command line, use mycmdsXML2DAT.exe with the syntax shown above to convert the XML file to DAT format.
3. Use the nsadmin utility to copy the .dat file to the Data Distribution directory. For more information, see the nsadmin Help file available in the Help folder of your installation directory (by default, C:\Program Files\Nuance\NaturallySpeaking14\Help).

The next time a user opens a user profile, Dragon incorporates the new commands from the .dat file into the user profile.

To distribute commands in the NMC console, see “Working with Command Sets” in the Nuance Management Center Administrator Guide.
Chapter 13: Working with Custom Commands

Using the MyCommands Protection Utility

In Dragon Group, you can protect custom Text-and-Graphics, Step-by-Step, Macro Recorder, and Advanced Scripting commands by exporting them into a .dat file, and then running the MyCommands Protection Utility included in your Dragon installation. After they are imported to the Dragon client, users can use the commands, but cannot view or edit their source code or re-export the commands. As a result, the integrity of the commands remains intact.

To protect the commands in a .dat file:

1. Make a backup copy of the unprotected .dat file and store it in a secure location.
   
   When you protect the .dat file that you are distributing, you cannot make the file available for editing again.

2. Open a command prompt.

3. Change directories to the Program folder inside your installation directory. By default:
   
   C:\Program Files\Nuance\NaturallySpeaking14\Program

4. Enter the following on the command line:
   
   protectcmds.exe <dat-file-path> <vendor-name> [vendor-contact-info]

If a user attempts to view, copy, or edit commands from a protected file, the following message appears:

**The command was protected by <vendor-name>.**

**Please contact <vendor-contact-info> for more information.**

In the Command Browser, the same message appears as the Preview Content in Script mode.

When you have protected the file, you can place it in the Data Distribution directory for distribution to multiple user profiles, and then use the nsadmin command line tool. For more information, see the nsadmin Help file available in the Help folder of your installation directory (by default, C:\Program Files\Nuance\NaturallySpeaking14\Help).

To distribute commands in the NMC console, see “Working with Command Sets” in the Nuance Management Center Administrator Guide.
Chapter 14: Upgrading the Dragon client

Preparing to upgrade Dragon ................................................................. 82
  Export user profiles ........................................................................... 82
  Optional: Export custom words ......................................................... 82
  Optional: Export custom commands .................................................. 82
Upgrading Roaming User Profiles ..................................................... 84
  Before you upgrade ........................................................................... 84
  After upgrading Roaming user profiles .............................................. 85
Upgrading Your Dragon installation from the Command Line .......... 86
  Upgrading with settings ..................................................................... 86
  Upgrading from the command line ..................................................... 86
  Using setup.exe for silent upgrades ................................................... 86
Upgrading with msiexec.exe ............................................................... 88
Upgrading user profiles ...................................................................... 90
  Running the Upgrade User Profiles Wizard ...................................... 90
  Importing custom words and commands .......................................... 91
Preparing to upgrade Dragon

Export user profiles

Before you upgrade, consider exporting user profiles in case you need to re-install.

1. On the DragonBar, select Profile > Manage User Profiles.
   The Manage User Profiles dialog opens.
2. Select the user profile to export.
4. When the Browse For Folder dialog box opens, navigate to the folder where you want to store the exported user profile, or create a new folder by clicking the Make New Folder button. Then, click OK.
5. When a dialog box opens displaying a message indicating the export was successful, click OK.
6. Repeat steps 2 through 5 for each set of user profiles you want to export.
7. Click Close to exit the Manage User Profiles dialog box.
8. In the operating system, navigate to the directory where you exported the user profiles. In that directory, there is a separate folder for each exported user profile, labeled with the user name.

For more information on exporting profiles, see “Working with user profiles” in the Dragon Help site.

Do not export profiles to a folder in the Dragon directory. These directories may be deleted if Dragon is uninstalled.

Optional: Export custom words

Your user profiles’ vocabulary may be enhanced by custom words or phrases the user added manually through the Vocabulary Editor or the email and document analysis feature and words Dragon learned during the process of correcting misrecognitions.

Consider exporting any custom words to create a backup copy in case you need to re-install the previous version.

To check for custom entries in your vocabulary:

1. From the DragonBar, select Vocabulary > Open Vocabulary Editor.
2. Select Custom words only from the Display drop-down list.

If the user profile includes custom words, do the following to export them into a file:

1. From the DragonBar, select Vocabulary > Export custom word and phrase list.
2. In the Save window, specify a name for the list, then choose a format, .xml or .txt, in the Save As Type drop-down list. By default, the custom words are saved as a .txt file.
3. Select a Windows folder.
4. Click Save.

Optional: Export custom commands

If your user profiles contain custom commands imported or created in Dragon, consider exporting them to have a backup in case you need to re-install.

To export custom commands:
1. From the DragonBar, select **Tools > Command Browser**.
2. In the Command Browser window, click the **Mode** menu, then select **Manage**.
3. To export only custom commands, choose **User-Defined** in the **Group** drop-down list.
4. Click the plus sign (+) to expand the list of commands.
5. Select the check-box next to the commands to export.
6. Click the **Manage** menu, and then select **Export**.
7. In the Save window, specify a name for the file, and then choose a Windows folder.
8. Click **Save**.
Upgrading Roaming User Profiles

If you are upgrading from Dragon Professional version 12 or 12.5, you must upgrade your user profiles before using them. For Roaming user profiles, an administrator should upgrade the Master Roaming user profiles before upgrading the Dragon clients. You can use version 13 or 13.5 profiles without upgrading.

Since the Local Roaming user profile is a copy of the Master Roaming user profile, you do not need to upgrade the Local Roaming user profile on each user's client computer when upgrading Dragon. Instead, install Dragon Group on the network computer where the current Master Roaming user profiles are located and upgrade the Master Roaming user profiles. Administrators can then upgrade client computers using the Roaming feature.

- Although the User Profile Upgrade Wizard supports both mapped drives and UNC paths, Nuance strongly recommends upgrading the Master Roaming user profiles on a computer where Dragon Group is locally installed. Upgrading over a network takes an undetermined length of time. In addition, the User Profile Upgrade Wizard does not support upgrading user profiles over an HTTP connection.
- Plan to upgrade the Master Roaming user profiles at a time when they are not being opened by users – for example, during the night or on a weekend. If there is not a time when none of the Roaming user profiles are in use, you can upgrade different groups of Roaming user profiles at different times.
- Nuance recommends backing up user profiles before upgrading them. Back up the Master Roaming user profiles to a separate location using any system backup utility that is implemented at your facility.

Before you upgrade

1. Install or upgrade Dragon Group on the computer where the current Master Roaming user profiles are located.

   If you cannot install Dragon where the current Master Roaming user profiles are located, Nuance recommends that you copy the current Master Roaming user profiles to a separate computer, install the upgraded version of Dragon Group on that machine, and then continue the Master Roaming user profile upgrade. When the upgrade is complete, copy the Master Roaming user profiles back to the network-accessible directory.

2. **NMSUsers**: To upgrade Roaming user profiles, you must make sure that NMS is **disabled** for this installation of the Dragon client.
   a. On the administrator system where you will upgrade the Master Roaming profiles, start Dragon.
   b. On the DragonBar, click **Tools > Administrative Settings**.
   c. In the NMS Settings tab, ensure **Enable NMS is unchecked**. You can re-enable NMS after you have upgraded your Master Roaming user profiles.

   If you skip this step, you must disable Roaming for the entire Site in the NMC console (see “Configuring the location of Roaming user profiles” in the **Nuance Management Center Administrator Guide**).

3. On the central network location that stores the current Master Roaming user profiles, create a new
Chapter 14: Upgrading the Dragon client

directory to store the upgraded Master Roaming user profiles.

Always be sure the upgraded user profiles are in a different location from the current user profiles. If users see two versions of each user profile, they may become confused when they try to open a user profile.

4. Disable the Roaming feature. If you skip this step, the Upgrade User Profiles Wizard displays an error message stating that you cannot upgrade a Roaming user profile.
   a. On the administrator system where you are upgrading the Master Roaming profiles, start Dragon.
   c. When the Administrative Settings dialog opens, click the Roaming tab and make sure Enable is not selected.
   d. Click OK, and then close Dragon.

5. Upgrade the Master Roaming user profiles using the Upgrade User Profiles Wizard (see “Upgrading user profiles” on page 90).

Since the User Profile Upgrade Wizard leaves the original Master Roaming user profiles unchanged and in their original network location, the Dragon clients can continue to use the Roaming feature until you upgrade the systems. Follow the steps in “Upgrading with msiexec.exe” on page 88.

After upgrading Roaming user profiles

If you copied the Master Roaming user profiles to a separate computer for upgrading, ensure you copy the upgraded profiles back to the new network-accessible directory that you created to store them (see step 3).

After upgrading the Dragon clients, remember to update the Roaming User Network Directories to point to new, upgraded the Roaming user profiles. For instructions, see “Setting the location of Master Roaming user profiles” in the Dragon Help site (for Stand-Alone users) or “Configuring the location of Roaming user profiles” in the Nuance Management Center Administrator Guide.

Stand-Alone users: Be sure to enable the Roaming feature when you upgrade the Dragon clients. See “Installing a Roaming user profile configuration on additional computers” on page 137 for details on configuring Roaming user profiles during installation.
Upgrading Your Dragon installation from the Command Line

There are two command line upgrade scenarios:

- **Major Upgrade**—Upgrading to a new edition or version of Dragon Group.
- **Minor Upgrade**—Upgrading to a higher point release within the same edition and version of Dragon.

Minor upgrades do not support the silent upgrade option. When you run setup.exe to install a minor upgrade, setup.exe can detect when a previous version of Dragon exists on a target computer. When it detects a previous version, setup.exe runs the rest of your installation in minor upgrade mode, automatically overwriting older files with newer files and adding any missing files.

A silent installation of Dragon does not display any messages. Check the setup log for any installation messages or errors.

**Upgrading with settings**

Although the upgrade does not migrate forward the configuration or Roaming user profile settings from the earlier version, you can install with your previous settings using one of the following methods:

- Reuse the nsdefaults.ini and (Stand-Alone users only) roamingdef.ini files you used when you first installed Dragon Group.
- Perform an initial installation of the new version of Dragon on a single computer (see “Installation Using the Dragon Command Line” on page 1) and establish the configuration you want to use by calling natspeak.exe on the command line (see “Natspeak.exe Command Line Options” on page 1).

Administrators cannot upgrade user profiles during the command line installation.

For Roaming user profiles, upgrade the profiles in the Master Roaming user profile directory before you upgrade the Dragon clients (see “Upgrading Roaming User Profiles” on page 84). Upgraded Roaming user profiles become available as soon as you update Dragon on the client computers.

For non-Roaming user profiles, run the User Profile Upgrade Wizard after installation completes. See “Upgrading user profiles” on page 90 for details on the User Profile Upgrade Wizard.

**Upgrading from the command line**

Before you begin your upgrade:

- Have the Dragon serial number available. If you are installing or upgrading Dragon on multiple networked computers, have the group serial number available.
- Ensure all mapped drives you plan to use are mapped on each client computer where you are distributing the installation.
- Install any pending Windows updates on clients and restart as needed.
- Copy any .ini files you want apply to your installation to a central location so you can access them later.

**Using setup.exe for silent upgrades**

When you use the command line, you must use the REINSTALL=ALL option and set REINSTALLMODE to the sub-options you want to reinstall, generally REINSTALLMODE=vamus. If you did not originally install in the
default location, make sure you use the INSTALLDIR option to point to your installation directory. Here is an example command line using setup.exe:

```
setup.exe /s /v"/i "Dragon 14.msi"
SERIALNUMBER=#####-####-####-####-####
REBOOT=ReallySuppress
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
REINSTALL=ALL REINSTALLMODE=vamus
/L*v C:\logfile.log /qn"
```

When you are using the setup.exe method, you must ensure that all flags and properties are within the same set of quotes, directly after /v, without a space. See “MSI options for Dragon installations” on page 118 for details on the MSI options available for Dragon installations.
Upgrading with msiexec.exe

When you use the msiexec.exe installer to uninstall Dragon from a command prompt, the installer automatically retains user profiles from the previous version of Dragon. After upgrading, users can upgrade their local (non-Roaming) user profiles when they start Dragon. To upgrade Roaming user profiles, see “Upgrading Roaming User Profiles” on page 84.

The table below lists GUIDs that you pass to the /x option of msiexec for each version of Dragon and Visual C++ Runtime for Dragon.NET framework 4.5. Make sure to use the /x option with the GUID.

<table>
<thead>
<tr>
<th>Products and versions</th>
<th>GUID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragon Group</td>
<td>{FEAB6184-0560-4EBF-A26BC3F2B11FE9E1}</td>
</tr>
<tr>
<td>DNS V13</td>
<td>{33EA20FB-5389-4938-BA59-2BCD9BB68F41}</td>
</tr>
<tr>
<td>DNS V12</td>
<td>{D5D422B9-6976-4E98-8DDF-9632CB515D7E}</td>
</tr>
<tr>
<td>VC-Runtime 32-bit</td>
<td>{4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}</td>
</tr>
<tr>
<td>VC-Runtime 64-bit</td>
<td>{4A5A427F-BA39-4BF0-9A47-7777FBE60C9F}</td>
</tr>
</tbody>
</table>

See “MSI options for Dragon installations” on page 118 for details on the MSI options available for Dragon installations. For more information on MSI options, see the Microsoft website: http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx.

To upgrade with msiexec.exe:

1. Open a command line window as an administrator (see “Windows elevated command prompts” on page 1).
2. To uninstall the current version of Dragon with msiexec.exe, pass the installer the /x option followed by the old version’s GUID (shown in the table above) and the /qn option to turn off any GUI.
   
   For example:
   ```
   msiexec /x {33EA20FB-5389-4938-BA59-2BCD9BB68F41} /L*v "C:\updatelog.log" /qn
   ```
   
   Include /L*v "C:\updatelog.log" if you want to create a log of the uninstall and/or update process. You can change "C:\updatelog.log" to a different location or file name.

   The first time you run an installation from the command line, you should use the /qf option rather than /qn. This allows you to see prompts that help you determine any problems with the command line.

3. Install the new version of Dragon with msiexec.exe by passing the installer the /i option followed by the name of the Dragon .msi file and installation options you want to include.
   
   For a major upgrade, pass REMOVEOLDPROD=1. This tells the installer to look for previous versions of Dragon and uninstall them. If no previous version of Dragon is found, the installation continues. In addition, pass DEFAULTSINI and set it to the full path to your modified nsdefaults.ini file. For example:
   ```
   msiexec /i "Dragon 14.msi"
   SERIALNUMBER=#####-####-####-####-####-
   REBOOT=ReallySuppress
   ```
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
REMOVEOLDPROD=1 /L*v "C:\logfile.log" /qn

For a **minor upgrade**, install the new version of Dragon with msiexec.exe as you would the major upgrade, but pass REINSTALL and REINSTALLMODE options, as shown in the sample below:

```
msiexec /i "Dragon 14.msi"
SERIALNUMBER=#####-####-####-####-####-
REBOOT=ReallySuppress
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
REINSTALL=ALL REINSTALLMODE=vamus
/L*v "C:\logfile.log" /qn
```

Here, REINSTALL is set to ALL and REINSTALLMODE is set to vamus.

For more information on the REINSTALL and REINSTALLMODE settings, refer to “**MSI options for Dragon installations**” on page 118.

If you do not pass the REINSTALL and REINSTALLMODE options, the minor upgrade does not complete successfully.

If you are using Roaming user profiles in Stand-Alone mode, be sure to include your roamingdef.ini file (see “**Installing a Roaming user profile configuration on additional computers**” on page 137).

**Edit the NSSYSTEM.INI file**

After you install Dragon using a script, you must edit the nssystem.ini file so that Dragon can find existing profiles from the previous version and launch the Upgrade User Profile Wizard when the user opens Dragon.

Edit the nssystem.ini from the machine where you performed the installation. Do not copy the nssystem.ini file from a different computer where you installed Dragon.

1. Navigate to C:\ProgramData\Nuance\NaturallySpeaking14.
2. Use a text editor like Notepad to open the nssystem.ini file.
3. In the nssystem.ini file, in the [Settings] section, add the following line:
   ```ini
   Old Users Directory=<path to previous Dragon version profiles>
   ```
4. Save the nssystem.ini file.
Upgrading user profiles

If your organization used Dragon Professional version 12 or 12.5, you will need to upgrade your user profiles before using them. Version 13 or 13.5 profiles can be used without upgrading.

When you upgrade the Dragon client, the Upgrade User Profiles Wizard launches when the user first attempts to open a version 12 or 12.5 user profile. The Upgrade User Profiles Wizard walks users through the process of upgrading profiles stored on the local machine. For Roaming user profiles, an administrator should upgrade the Master Roaming user profiles before upgrading the Dragon clients (see “Upgrading Roaming User Profiles” on page 84).

You can also run the Upgrade User Profiles wizard from the Start menu:

- Windows 7: Click Start > All Programs > Dragon > Dragon Tools > Upgrade User Profiles
- Windows 8.x: From the Start screen, click the down arrow to show all apps. Scroll to Dragon, then find Upgrade User Profiles
- Windows 10: Click Start > All apps > Dragon > Upgrade User Profiles

Although the User Profile Upgrade Wizard supports both mapped drives and UNC paths, Nuance strongly recommends upgrading the Master Roaming user profiles on a computer where Dragon Group is locally installed. Upgrading over a network takes an undetermined length of time.

Running the Upgrade User Profiles Wizard

1. On the Select the profile(s) to upgrade page, a list of any user profiles stored in the default directory appears. To upgrade other profiles, click Browse to add a profile and select the location of the user profiles to be upgraded. The Select the profile(s) to upgrade page now displays all user profiles in the selected directory or directories:

   Click Browse to add a profile to add user profiles from other local folders or Remove from list to remove specific user profiles. Click Next to continue.

2. If you choose to upgrade only one user profile, the wizard confirms the user to be upgraded and the estimated time required.

3. (Optional for non-Roaming users) On the Choose where to store the upgraded profile(s) page, under Location for upgraded profile(s), choose the directory where you want to store upgraded user profiles. If no location is visible, click the Browse button and find the correct location.

4. (Optional) Click Advanced if you would like to select a new Base Vocabulary or Acoustic Model for one or more of your upgraded user profiles.

   Click OK when you are done to return to the Choose where to store upgraded profile(s) page.

5. Click Next to proceed.

6. The Begin profile upgrading page displays the number of user profiles that the wizard is prepared to upgrade.

   Click Begin upgrading to start the upgrade process. The upgrade process can take 12-24 minutes or more per user profile, depending on the speed of the computer system. Click Stop at any time to interrupt this process.

7. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

   The upgrade process creates new user profiles in the destination you selected.
Importing custom words and commands

If you are using Stand-Alone mode, you must import any custom words and commands your user profiles included. These are not automatically included in the user profile upgrade.

- To distribute words and commands to all users, you can use the nsadmin.exe tool. For more information, see the nsadmin Help file available in the Help folder of your installation directory (by default, C:\Program Files\Nuance\NaturallySpeaking14\Help).

- To manually import words and commands to individual Dragon clients, see “Exporting and importing a list of custom words and phrases” and “Exporting and importing commands” in the Dragon Help site.
Chapter 15: Managing Logs and Errors

- Dragon logs ................................................................. 93
- Dragon client logs ....................................................... 93
- Usability logs (Stand-Alone mode only) ....................... 94
- Handling Dragon error messages ................................. 95
- Accessing the Dragon Knowledge Database .................. 96
Dragon logs

Dragon Group generates logs that can help troubleshoot your system. If you call Technical Support, you might be asked to provide one or more of these logs to help Nuance engineers work on any issues with your network.

Users can view additional logs in the Nuance Management Center (NMC) console (see the “View log files for a variety of products and product components” section in the Nuance Management Center Administrator Guide).

> Dragon regularly purges all logs and does not back them up automatically. To save your logs for longer periods, back them up to another location.

Dragon client logs

The Dragon client creates log files, dragon.log and dgnsetup.log, which you can view on the user’s machine:

C:\ProgramData\Nuance\NaturallySpeaking14\logs\<WindowsUser>

You can also access this directory through a shortcut in the Start menu:

- Windows 7: Click Start > All Programs > Dragon > Show Setup Log or Show Dragon Log
- Windows 8.x: From the Start screen, click the down arrow to show all applications. Scroll to find Dragon, then find Show Setup Log or Show Dragon Log.
- Windows 10: Click Start > All apps > Dragon> Show Setup Log or Show Dragon Log

> If you do not see the Show Dragon Log or Show Setup Log shortcuts in the Start menu, try logging out, then logging back in again.

The current Dragon log filename is Dragon.log. When this file exceeds 10 MB, it is appended with the date and time in the format Dragon_YYYYMMDD_HHMMSS.log and a new log file is created.

The hour is shown in 24-hour format. For example, Dragon_20150820_155023.log is the name of a log created on August 20, 2015 at 15:50:23 (or 3:50:23 PM).

Dragon stores the last 10 log files.

Manually creating a new Dragon log file

An administrator can start a new Dragon log file when Dragon starts.

1. Open text editing software such as Notepad.
   On Windows 7, Windows 8.x, and Windows 10, make sure you have administrator rights when you open the text editor (use the “Run as administrator” option to open the text editor).
2. In the text editor, navigate to the folder that contains the nssystem.ini file. The default location of the nssystem.ini file is:
   C:\ProgramData\Nuance\NaturallySpeaking14
3. In the text editor, open the nssystem.ini file.
4. In the [Settings] section, add the following line of text: New Log On Startup=1.
5. Save and close the nssystem.ini file.
6. To activate the setting, re-open the user profile.
Usability logs (Stand-Alone mode only)

You can set up Dragon to create a usability log that logs all menu commands, toolbar buttons, and voice commands that you use during a dictation session.

To set up a usability log:

1. With a user profile open, on the DragonBar, select Tools > Options.
2. Click the Data tab.
3. Click the Advanced button.
4. When the Advanced dialog box opens, check the Create usability log checkbox and click OK to return to the Data tab.
5. Click Apply, then click OK to close the Options dialog box.

By default, the log is located here:

`C:\Users\<Windows_user>\AppData\Roaming\Nuance\NaturallySpeaking14`
Handling Dragon error messages

When Dragon displays an error message:

1. Read the message carefully. It may give you enough information to determine what to do.
2. If you dictated text into your document, click Close to close the error message box and then save your document.
3. Do not save your user profile.
4. Copy the error message log file (Dragon.log) to a safe place. Technical Support may ask you to send this file for further study. In Dragon Group, the Dragon.log file is located in the following directory:
   
   C:\ProgramData\Nuance\NaturallySpeaking14\logs\<WindowsUser>

5. Exit Dragon and start it again. In some cases it may be necessary to restart your computer.
6. Insert your Dragon DVD, run the installation program again, and choose the Repair option on the first screen of the Dragon setup program. After setup finishes, reinstall any Dragon patches that were previously installed.
7. If the error message does not provide enough information to determine what to do, search our website for information on the error message. You may find a solution that can save you time and trouble:

Accessing the Dragon Knowledge Database

Solutions to known problems with Dragon are provided at the Nuance Knowledge Base, located at http://nuance.custhelp.com/.

1. In the search field, type keywords related to your problem.
2. Click the magnifying glass to start the search.

For an Advanced Search, click Advanced Search, then fill in some or all of the following fields in the popup window that appears:

1. Select your product in the drop-down list in the Limit by product field.
2. Refine your product by version number and edition as needed (for example, Dragon NaturallySpeaking > 14 > Dragon Professional).
3. In the Limit by Category drop-down list, select a category to further refine the search criteria.
4. In the Sort by direction field, choose whether results should be sorted in ascending or descending order.
5. Click Search.
Chapter 16: Using Dragon over a remote desktop connection

This chapter contains information on setting up and using the Dragon client through a remote desktop connection.

Use Dragon through a remote desktop connection .......................................................... 98
Remote desktop connection support ................................................................................. 99
  Support for dictation sources over a remote desktop connection .................................. 99
  System Requirements for using Dragon through a remote desktop connection .............. 99
Installing Dragon on the server and the client ................................................................. 101
Configuring the Windows server ..................................................................................... 102
Configuring Windows Server 2008 R2 ........................................................................ 103
Configuring Windows Server 2012 R2 Part 1 ................................................................ 107
Configuring Windows 7 Ultimate Server ...................................................................... 112
Configuring the Dragon clients ....................................................................................... 113
  User Profiles and using Dragon through a Remote Desktop session ............................ 116
Use Dragon through a remote desktop connection

For remote desktop system requirements, see “System Requirements for using Dragon through a remote desktop connection” on page 1.

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Dragon on the server and install Dragon Client for Remote Desktop</td>
<td>“Installing Dragon on the server and the client” on page 101</td>
</tr>
<tr>
<td>Set up the Windows server options</td>
<td>“Configuring the Windows server” on page 102</td>
</tr>
<tr>
<td>Set up client computers by setting audio policies and the Remote Desktop Connection 7</td>
<td>“Configuring the Dragon clients” on page 113</td>
</tr>
</tbody>
</table>
Remote desktop connection support

You can use Dragon through a remote desktop connection with the following operating systems:

<table>
<thead>
<tr>
<th>Server Operating Systems</th>
<th>Client Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008 R2 and Windows Server 2012 R2</td>
<td>• Windows 10, (32-bit and 64-bit)</td>
</tr>
<tr>
<td>Windows 7 Ultimate and Enterprise Server</td>
<td>• Windows 8, (32-bit and 64-bit)</td>
</tr>
<tr>
<td>Windows 10 Professional, Enterprise and Education</td>
<td>• Windows 7, (32-bit and 64-bit)</td>
</tr>
<tr>
<td>Windows 8 Professional and Enterprise</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2012 R2 and 2008</td>
<td></td>
</tr>
</tbody>
</table>

To transmit audio from the client computer to Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server running Dragon Group, you must:

- Enable the audio recording option on the remote client software.
- Enable the audio recording redirection policy on the server.

This configuration allows one Windows client computer to access and use a single installation of Dragon Group on the server.

Support for dictation sources over a remote desktop connection

In Dragon Group, you can use the following dictation sources over a remote desktop connection:

- **USB microphone**
- **Other microphone**: Microphone plugged into Mic-In jack
- **Headset**: Andrea NC-181
- **Bluetooth**: Plantronics Calisto Bluetooth Headset

Using Dragon Group on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server:

- The Remote Audio suggested for the user profile is the default microphone on your client computer.
- If you are using the Remote Application web interface - When you launch Dragon Group from the Remote Desktop Connection, if you launch the DragonBar in Docked-to-Top or Docked-to-Bottom mode, the Dragon menus will not be visible. To access the menus, you need to switch to work with Floating, Clinging, or the Tray Icon mode.

System Requirements for using Dragon through a remote desktop connection

- **Server Operating System**: Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server

  Window Server 2008 R2 and Windows Server 2012 R2 support multiple client connections at the same time. Windows 7 servers supports only a single client connections at one time.

- **Client Operating System**: The following operating systems support Remote Desktop Connection 7:
  - Windows 10, 32-bit and 64-bit
  - Windows 8.x, 32-bit and 64-bit
- Windows 7, 32-bit and 64-bit
- **Client Hardware:**
  - **Disk space:**
    - 2 MB for the Remote Desktop Client version 7 (from Microsoft)
    - 8 MB for the Dragon client
  - USB port for the microphone
- **Server Hardware:** To support 6 concurrent users connecting to Dragon Group on a server, the minimum requirements are:
  - **Cache:** 1 MB L2 cache per CPU
  - **CPU:** 3.x Ghz
  - **Disk space:** 5 GB
  - **Processor:** Multi-core processor with 4 cores
  - **RAM:** 16 GB DDR2 RAM
- **Microphone:**
  - USB microphone
  - **Other microphone:** Microphone plugged into Mic-In jack
- **Headset:** Any Nuance-approved headset. For details, visit [http://support.nuance.com/compatibility/](http://support.nuance.com/compatibility/) to view the Hardware Compatibility List.
- **Bluetooth:** Plantronics Calisto Bluetooth Headset
- **Software:** Remote Desktop Connection 7 (RDP 7). The RDP 7 download is available at [http://support.microsoft.com/kb/969084](http://support.microsoft.com/kb/969084) and works for all operating systems.
- **Network:**
  - 100 Mbps connection speed
  - Network bandwidth required per active user is 1.3 Mbps
Installing Dragon on the server and the client

To enable audio redirection through a remote desktop connection, and allow users to connect and use Dragon Group on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server, you install and configure software on both the client computers that will connect to Dragon on the server, and on the server machines. You can expect to spend around thirty minutes installing and configuring the required software.

Perform the following steps:

1. Install Dragon on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server.

2. Install the Dragon Client For Remote Desktop on each client computer that will connect to Dragon on a server.
   1. In Windows Explorer, navigate to the "DragonClientForRemoteDesktop" folder on your Dragon DVD.
   2. To install Dragon client for Remote Desktop using the MSI Windows Installer, run dragon-clientinstaller.msi; otherwise, run setup.exe.
   3. The Dragon Client For Remote Desktop installation includes:
      - **Audio Setup Wizard**—A stand-alone application that provides a way to check that your microphone sound levels and signal quality are suitable for using Dragon Group with a remote desktop connection.
Configuring the Windows server

1. Ensure the server computer meets the system requirements.
   For more information, see “System Requirements for using Dragon through a remote desktop connection” on page 1.
3. If you are using Windows Server 2008 R2, perform the steps in “Configuring Windows Server 2008 R2” on page 103.
4. If you are using Windows Server 2012 R2, perform the steps in “Configuring Windows Server 2012 R2 Part 1” on page 107.
5. If you are using Windows 7 Ultimate Server, perform the steps in “Configuring Windows 7 Ultimate Server” on page 112.
6. If you are using Windows 10, see How to use Remote Desktop on the Microsoft site (http://windows.microsoft.com/en-us/windows-10/how-to-use-remote-desktop).
7. Proceed to “Configuring the Dragon clients” on page 113.
Chapter 16: Using Dragon over a remote desktop connection

Configuring Windows Server 2008 R2

Perform the following steps to install and configure the Remote Desktop Services role.

1. Open Remote Desktop Connection.
2. Open the Server Manager.
3. Select Roles.
4. Select Add Roles.
5. On the Before You Begin screen, click Next.
8. On the Select Role Services screen, select Remote Desktop Session Host, click Next.
10. Select **Do not require Network Level Authentication**, click **Next**.

11. On the Specify Licensing Mode screen, click **Next**.
12. Click **Next**.
13. Select the **Audio and video playback** option and the **Audio recording redirection** option and click **Next**.

14. Confirm your selections, and click **Install**.
The Installation Progress screen display the status of the installation.

15. On the Installation Results screen, verify that the installation was successful. Click Close.

16. Restart the computer.

Perform the following steps to configure the local group policy on the server and to allow connections from client computers.

1. On the server, in a command prompt, run gpedit.msc.


3. Enable the Allow audio and video playback redirection option: on the Allow audio and video playback redirection screen, select Enabled and Press OK.

4. Enable the Allow audio recording redirection option: on the Allow audio recording redirection screen, click Enabled and Press OK.

5. Launch regedit on the client PC and set the following registry setting to 0:

   HKLM\SYSTEM\CurrentControlSet\Control\Terminal Server\WinStations\RDP-Tcp
   fDisableAudioCapture REG_DWORD0x00000000

6. On the server, open the Control Panel.


8. Select Remote.

9. Allow remote connections by choosing your preferred configuration.

10. Click OK.

Configuring Windows Server 2012 R2 Part 1

1. Open Remote Desktop Connection to the server or go directly to the server console.
2. Open the server, then open the Server Manager.
3. On the Dashboard, select Add roles and features to open the Add Roles and Features wizard.
4. Click Before You Begin, then click Next.
5. Select Role-based or feature-based installation, then click Next
6. On the **Select destination server** screen, select **Select a server from the server pool**. Select the server and click **Next**.
Chapter 16: Using Dragon over a remote desktop connection

7. On the **Select Server Roles** screen, select **Remote Desktop Services**, then click **Next**.

![Image of the Select Server Roles screen]

8. On the **Select features** screen, open the **Remote Server Administration Tools** submenu.

9. Open the **Role Administration Tools** submenu.

10. Open the **Remote Desktop Services Tools** submenu.

11. Select **Remote Desktop Licensing Tools** and click **Next**.

12. On the **Remote Desktop Services** screen, click **Next**.

13. On the **Select role services** screen, select **Remote Desktop Session Host**.
14. On the next screen, click **Add Features**, then click **Next**.

![Add Roles and Features Wizard](image)

15. On the **Confirm installation selections** screen, check **Restart the destination server automatically if required**.

16. In the **Add Roles and Features** wizard, click **Yes**.

17. Confirm your selections, then click **Install**.

18. The **Installation Progress** screen displays that status of the installation.

19. On the **Installation progress** screen, verify that the installation was successful.
20. Click Close.

21. Restart the computer (even if the server was not restarted automatically).

Perform the following steps to configure the local group policy on the server and to allow connections from client computers.

1. On the server, in a command prompt, run \gpedit.msc.

2. Navigate to **Computer Configuration > Administrative Templates > Windows Components > Remote Desktop Services > Remote Desktop Session Host > Device and resource redirection.**

3. Enable the **Allow audio and video playback redirection** option: right-click on the **Allow audio and video playback redirection** screen and select **Edit**.

4. Select **Enabled**, then click **OK**.

5. Launch regedit on the client PC and set the following registry setting to 0:
   
   ```
   HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Terminal Server-\WinStations\RDP-Tcp\DisableAudioCapture REG_DWORD=0x00000000
   ```

6. On the server, open the **Control Panel**.

7. Navigate to **System and Security > System**.

8. Select the **Remote settings > Remote** tab.

9. Allow remote connections by choosing your preferred configuration.

10. Click **OK**.

Configuring Windows 7 Ultimate Server

1. On the Windows 7 Ultimate Server, open the Control Panel.
2. Open System Properties.
3. Click the Remote tab.
4. Allow remote connections by choosing your preferred configuration.
5. Proceed to “Configuring the Dragon clients” on page 113.
Configuring the Dragon clients

After you install Dragon Group on the server and Dragon Client for Remote Desktop on each client computer, perform the following steps on each client computer that need to connect to Dragon Group on the server.

1. Ensure the client computer meets the system requirements. See “System Requirements for using Dragon through a remote desktop connection” on page 1 for more information.

2. On the client, plug in the microphone that you will use to dictate with Dragon Group. Then run the Audio Setup Wizard to check that microphone sound levels and signal quality are suitable.

3. Ensure Remote Desktop Connection 6.1 (RDC 6.1) or higher is installed on the client computer. If it is not, visit the following link to download Remote Desktop Connection 7.0 client update http://support.microsoft.com/kb/969084.

4. When you start Remote Desktop Connection 7, in the Remote Desktop Connection dialog box, click Options.
5. Select the **Local Resources** tab, click **Settings**.
6. Select **Play on this computer** and **Record from this computer**, and click **OK**. Selecting these options enables audio support each time the user opens the remote connection to use Dragon Group on Windows Server 2008 R2 or Windows Server 2012 R2.

7. In the Windows sound settings, verify that Remote Audio device appears.

![Remote Desktop Connection settings](image)

![Sound settings](image)
User Profiles and using Dragon through a Remote Desktop session

Dragon users must perform four minutes of short training when they create a user profile. It is not possible to skip user profile training when Dragon Group is installed on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server and when using Remote Desktop Connection 7.

Dragon users can user profiles created on Dragon workstations without performing additional training on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server.

Nuance recommends that you create and train a user profile or add a dictation source to an existing user profile while Dragon is running in a Remote Desktop session. If you use an existing profile with a dictation source that was trained while Dragon was running on your workstation, poor accuracy may result.
Appendix A: Options for MSI Installations

MSI options for Dragon installations ................................................................. 118
Sample command lines ......................................................................................... 121
Feature variables to set through the ADDLOCAL or ADVERTISE properties .......... 123
Speech options ..................................................................................................... 124
MSI options for scheduled tasks .......................................................................... 126
Editing Miscellaneous and Scheduled Task settings in nsdefaults.ini ............... 127
Extracting MSI/MST Files from the Dragon setup.exe ......................................... 129
MSI options for Dragon installations

This section describes the msiexec.exe options that apply to Dragon Group. For more information on MSI options, see the Microsoft website: http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx.

- Launching msiexec.exe /i "Dragon 14.msi" <PROPERTY>=<VALUE> automatically sets the specified <PROPERTY> to <VALUE> and continues the installation. However, if you use setup.exe to install, you must put all msiexec.exe options in quotation marks after the /v option:
  
  setup.exe /v"<PROPERTY>=<VALUE>"

- Be sure that the values that you pass to the MSI are valid. Entering an invalid value can cause the installer to crash.

- Dragon command line options do not need to be prefaced by hyphens or slashes.

- In Dragon Group, the installation process does not present the QuickStart option. To enable this option, you can do so after Dragon is installed.

- Unless noted otherwise, all property values are in UPPERCASE.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULTSINI=&quot;c:\path\nsdefaults.ini&quot;</td>
<td>Indicates a default settings file (nsdefaults.ini) that the installer uses to change the product settings for all users at installation time. This file must be in an .ini file format; any settings you want to include must have a section name encased in square brackets as well as the value and data. If the section name is missing, the settings are not propagated on client computers. Generally, you should not edit the nsdefaults.ini file directly; instead, set defaults in Dragon’s Options and Administrative Settings dialog boxes during your initial installation, then use the nsdefaults.ini from that installation.</td>
</tr>
<tr>
<td>ROAMINGUSERINI=&quot;c:\path\roamingdef.ini&quot;</td>
<td>Indicates a default settings file (roamingdef.ini) used to configure Roaming network settings. For more information about Roaming user settings, see “Setting Roaming user profile options” on page 132.</td>
</tr>
<tr>
<td>SERIALNUMBER=abcde-fgh-ijkl-mnop-qr</td>
<td>A serial number is required for all installations. You must specify a valid serial number on the command line. Specifying a serial number on the command line does not bypass the serial number checking during Setup.</td>
</tr>
<tr>
<td>INSTALLDIR=&quot;&lt;path to install&gt;&quot;</td>
<td>Sets the installation directory to the specified location. For an administrative installation, pass the TARGETDIR option instead of the INSTALLDIR option.</td>
</tr>
<tr>
<td>REBOOT=ReallySuppress</td>
<td>Prevents the computer where you are installing Dragon from restarting automatically after the installation ends.</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SETDEFAULTS=0/1</td>
<td>Sets the default state of the <strong>Modify the application’s settings for all users</strong> check box in the Advanced dialog of the Installer.</td>
</tr>
<tr>
<td></td>
<td>0: Check box is deselected. The Options dialog box does not appear during installation.</td>
</tr>
<tr>
<td></td>
<td>1: (Default) Check box is selected. The Options dialog box appears during installation.</td>
</tr>
<tr>
<td></td>
<td>If you use the /qn switch, no dialogs appear during installation, even if you set them to display in the command line.</td>
</tr>
<tr>
<td>SETADMINS=0/1</td>
<td>Sets the default state of the <strong>Modify the administrative settings</strong> check box in the Advanced dialog of the Installer.</td>
</tr>
<tr>
<td></td>
<td>0: Check box is deselected. The Administrative Settings dialog box does not appear during installation.</td>
</tr>
<tr>
<td></td>
<td>1: (Default) Check box is selected. The Administrative Settings dialog box appears during installation.</td>
</tr>
<tr>
<td></td>
<td>If you use the /qn switch, no dialogs appear during installation, even if you set them to display in the command line.</td>
</tr>
<tr>
<td>SETFORMATTINGS=0/1</td>
<td>Sets the default state of the <strong>Modify the formatting options for all users</strong> check box in the Advanced dialog of the Installer.</td>
</tr>
<tr>
<td></td>
<td>0: Check box is deselected. The Auto-Formatting dialog box does not appear during installation.</td>
</tr>
<tr>
<td></td>
<td>1: (Default) Check box is selected. The Auto-Formatting dialog box appears during installation.</td>
</tr>
<tr>
<td></td>
<td>If you use the /qn switch, no dialogs appear during installation, even if you set them to display in the command line.</td>
</tr>
<tr>
<td>PERIODIC_TASK=&lt;tasks&gt;;&lt;admin&gt;;&lt;password&gt;;&lt;Day&gt;, <a href="">hh:mm</a></td>
<td>Configures the Acoustic Model Optimizer, Language Model Optimizer and (Stand-Alone only) Data Collection tasks in the Scheduled Tasks tab of the Administrative Settings dialog. See “MSI options for scheduled tasks” on page 126 for details.</td>
</tr>
<tr>
<td>REGION=&lt;region&gt;</td>
<td>Set the REGION to include with your installation. For English-language installations, available regions are:</td>
</tr>
<tr>
<td></td>
<td>• United States (UnitedStates or US)</td>
</tr>
<tr>
<td></td>
<td>• Canada (Canada)</td>
</tr>
<tr>
<td></td>
<td>• United Kingdom (UnitedKingdom or UK)</td>
</tr>
<tr>
<td></td>
<td>• Australia/New Zealand (Australia or NewZealand)</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Indian subcontinent (IndianSubcontinent or Indian)</td>
</tr>
<tr>
<td></td>
<td>• Southeast Asia (SoutheastAsia or Asia)</td>
</tr>
<tr>
<td></td>
<td>To install all English-language regions, set REGION=All.</td>
</tr>
<tr>
<td></td>
<td>Set REGION=NoEnglish or REGION=None if you do not need to install any English-language regions.</td>
</tr>
<tr>
<td>ADDLOCAL=Feature1,Feature2,...</td>
<td>Set the ADDLOCAL property to a comma-delimited list of features to be installed locally. See “Feature variables to set through the ADDLOCAL or ADVERTISE properties” on page 123 for a list of available features.</td>
</tr>
<tr>
<td>ADDLOCAL=ALL</td>
<td>To install all features locally (including user profiles), use ADDLOCAL=ALL.</td>
</tr>
<tr>
<td>ADVERTISE=Feature1,Feature2,...</td>
<td>Set the ADVERTISE property to a comma-delimited list of features to be available but not locally installed.</td>
</tr>
<tr>
<td></td>
<td>The ADVERTISE option overrides the ADDLOCAL option. The best method for installing a particular set of features is to set the ADDLOCAL property to ALL and then set the ADVERTISE property to those features you do not want installed locally.</td>
</tr>
<tr>
<td>REINSTALL=Feature1,Feature2,...</td>
<td>Set the REINSTALL property to a comma-delimited list of features to be reinstalled.</td>
</tr>
<tr>
<td>REINSTALL=ALL</td>
<td>To reinstall all features, use REINSTALL=ALL.</td>
</tr>
<tr>
<td></td>
<td>If you set the REINSTALL property, you should also set the REINSTALLMODE property to indicate the type of reinstall to be performed.</td>
</tr>
<tr>
<td></td>
<td>Note that even if REINSTALL is set to ALL, only those features that were already installed previously are reinstalled.</td>
</tr>
<tr>
<td>REINSTALLMODE={type of</td>
<td>Set the REINSTALLMODE property to a string indicating the type of reinstall to perform. Options are case-insensitive and order-independent.</td>
</tr>
<tr>
<td>reinstallation to perform}</td>
<td>For a list of available modes, see <a href="https://msdn.microsoft.com/en-us/library/windows/desktop/aa371182">https://msdn.microsoft.com/en-us/library/windows/desktop/aa371182</a>.</td>
</tr>
<tr>
<td></td>
<td>The default is REINSTALLMODE=omus. The installer overwrites files if they are missing or an older version, rewrite required registry entries, and reinstall all shortcuts and icons.</td>
</tr>
<tr>
<td>REMOVEOLDPROD=1</td>
<td>Set REMOVEOLDPROD to 1 to remove the old version of the product before installing the new version. You should only use this option for major upgrades.</td>
</tr>
<tr>
<td>/x&lt;Product.msi</td>
<td>ProductCode&gt;</td>
</tr>
</tbody>
</table>
### Options for MSI Installations

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L&lt;parameter&gt; &quot;&lt;full path&gt;logfile.log&quot;</td>
<td>Creates an installation log in the specified location. To log all information, including verbose output, enter /L*v. You can send this log to technical support should any issues arise. For available parameters, see <a href="https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx#BKMK_SetLogging">https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx#BKMK_SetLogging</a></td>
</tr>
<tr>
<td>/q&lt;parameter&gt;</td>
<td>Sets the user interface level for the installation. For an initial installation, pass the /qf option to ensure that you see GUI prompts that will help you diagnose any issues that arise. Use /qn for a silent installation. For available parameters, see <a href="https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx#BKMK_SetUI">https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx#BKMK_SetUI</a></td>
</tr>
<tr>
<td>NAS_ADDRESS=&quot;&lt;Production server URL&gt;&quot;</td>
<td>Indicates the NMS address that the Dragon client connects to when the user logs on. You should have received this address in your welcome email.</td>
</tr>
<tr>
<td>NAS_WINDOW_LOGIN=0/1</td>
<td>Sets the Login Options radio button state in the NMS tab of the Administrative Settings dialog. Before you enable Active Directory single sign-on, you must make additional configuration changes. See “Single sign-on overview” on page 35 for more information. 0: (default) Disables Active Directory single sign-on; sets radio button to Provide a login name and password. 1: Enables Active Directory single sign-on; sets radio button to Use Windows single sign-on.</td>
</tr>
</tbody>
</table>

### Sample command lines

**msiexec.exe command line**

```bash
msiexec.exe /i "Dragon 14.msi"
SERIALNUMBER=#####-####-####-####-####
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
PRODUCTUPDATEFLAG=1 REBOOT=ReallySuppress
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
ADDLOCAL=TTSENX,NatSpeak,ENUGeneral
/L*v "C:\Logs\logfile.log" /qn
```

**setup.exe command line**

```bash
setup.exe /s /v"SERIALNUMBER=#####-####-####-####-####
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
```
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
ADDITIONAL=TTSENX,NatSpeak,ENUGeneral
/L*v C:\Logs\logfile.log /qn"
Feature variables to set through the ADDLOCAL or ADVERTISE properties

When specifying features on the command line:

- If a feature does not exist in a particular edition or language, overriding its default property has no effect.
- Some features (such as Text-to-Speech) have sub-features. Setting these features on the command line automatically turns on the properties of all sub-features, unless you specify an additional override for those sub-features.

You can specify any of the features in the table below using ADDLOCAL and ADVERTISE properties on the command line. For example:

```
ADDLOCAL=TTSENU,NatSpeak,ENUGeneral
```

<table>
<thead>
<tr>
<th>Feature</th>
<th>Sub-features</th>
</tr>
</thead>
<tbody>
<tr>
<td>NatSpeak</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td><strong>Required in ADDLOCAL; if not included, the installation will fail.</strong></td>
</tr>
<tr>
<td>Samples</td>
<td>None</td>
</tr>
<tr>
<td>(Sample Commands file)</td>
<td></td>
</tr>
<tr>
<td>TTS</td>
<td>• TTSENU (US English Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>• TTSENG (British English Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>• TTSDEU (German Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>• TTSESP (Spanish Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>• TTSFRA (French Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>• TTSITA (Italian Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>• TTSNLD (Dutch Text-to-Speech)</td>
</tr>
<tr>
<td>Tutorial</td>
<td>• TutENX (English Tutorial)</td>
</tr>
<tr>
<td></td>
<td>• TutDEU (German Tutorial)</td>
</tr>
<tr>
<td></td>
<td>• TutESP (Spanish Tutorial)</td>
</tr>
<tr>
<td></td>
<td>• TutFRA (French Tutorial)</td>
</tr>
<tr>
<td></td>
<td>• TutITA (Italian Tutorial)</td>
</tr>
<tr>
<td></td>
<td>• TutNLD (Dutch Tutorial)</td>
</tr>
</tbody>
</table>
### Speech options

<table>
<thead>
<tr>
<th>Feature</th>
<th>Sub-features: Vocabularies</th>
<th>Supported accents</th>
</tr>
</thead>
</table>
| ENU (US English) | • ENUGeneral (US English General Medium, US English Empty Dictation, US English Commands Only)  
• ENULegal (US English Legal Large)  
• ENUGenSvc (US English Large General)                                                                 | • Standard  
• Australian accented English  
• British accented English  
• Indian accented English  
• Pakistani accented English  
• Southeast Asian accented English  
• Southern US  
• Spanish accented English  
• Teens  
• Accent not otherwise specified |
| Canada (Canadian English) | • CanadaGeneral (Canadian English General Large)                                                                                   | • Standard  
• Australian accented English  
• British accented English  
• Indian accented English  
• Pakistani accented English  
• Southeast Asian accented English  
• Southern US  
• Spanish accented English  
• Teens  
• Accent not otherwise specified |
| ENG (UK English) | • ENGGeneral (UK English General Large, Empty Dictation General, Commands Only)                                                        | • Standard  
• Australian accented English  
• Indian accented English  
• Southeast Asian accented English  
• Accent not otherwise specified |
| DEU                                                                                                                                       | • DEUGeneral (German)                                                               | N/A |


## Appendix A: Options for MSI Installations

<table>
<thead>
<tr>
<th>Feature</th>
<th>Sub-features: Vocabularies</th>
<th>Supported accents</th>
</tr>
</thead>
<tbody>
<tr>
<td>(German)</td>
<td>General Large, Swiss German General, Empty Dictation General</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DEULega1 (German Legal)</td>
<td></td>
</tr>
<tr>
<td>ITA (Italian)</td>
<td>• ITA (Italian General Large and Italian Empty Dictation General Large)</td>
<td>N/A</td>
</tr>
<tr>
<td>NLD (Dutch)</td>
<td>• NLDGeneral (Dutch General Large and Dutch Empty Dictation General Large)</td>
<td>N/A</td>
</tr>
<tr>
<td>FRA (French)</td>
<td>• FRAGeneral (French General Large, French Empty Dictation General Large)</td>
<td>N/A</td>
</tr>
<tr>
<td>ESP (Spanish)</td>
<td>• ESP (Latin American Spanish General Large, Latin American Spanish Empty Dictation General Large, Castillian Spanish General Large)</td>
<td>N/A</td>
</tr>
</tbody>
</table>
MSI options for scheduled tasks

Take the following actions on the client computer. Do not perform them on the computer where you performed the initial installation and configured default option settings.

You can include an additional option on the command line to run one or more of the following tasks on a particular schedule:

- **Acoustic model optimization (ACO)**—This task optimizes the acoustic models used to interpret the user’s speech. You can set a particular date and time for this optimization to occur. When a speaker is new to Dragon, you might want to run the optimization more often.

- **Language model optimization (LMO)**—This task optimizes the language model (vocabulary files) used to help recognize words that the end-user speaks. The model incorporates data from the end-user’s speech into the language model he or she is using, customizing the model for that user profile.

- **Data collection (DC)**—This task automatically collects data that helps improve Dragon’s ability to recognize speech. You can choose to allow this data to be sent back to Nuance over the Internet on a particular schedule or choose not to send the data. This process does not collect your personal information. Data collection is available in non-US English versions of Dragon Group.

When NMS is enabled, you cannot schedule Data Collection tasks on the Dragon client machines. Administrators can schedule Data Collection in the NMC console. See “Turning on data collection for your site” in the *Nuance Management Center Administrator Guide* for details.

You can schedule the above tasks and turn them on or off by passing an option called PERIODIC_TASK to the MSI installer.

First, set PERIODIC_TASK to a string containing short acronyms for the types of tasks, separated by vertical bars: aco | lmo | dc

If you do not pass the acronym for a feature, that feature is set to its default.

Next, the string for PERIODIC_TASK should include the administrator login and password, followed by the schedule for each task, in the order that they occur in the string, separated by vertical bars.

- Enter the day(s) of the week for each task using three-letter abbreviations (Mon, Tue, etc.).
- Enter the hour using a 24-hour clock in the format hh:mm (05:00, 18:30, etc.).

For example, the string below sets the schedule for Acoustic Model Optimization to Mondays at 1 AM and the Language Model Optimization to Mondays at 6 AM:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

The task runs once a week on the day and time indicated. If you omit the day, the task runs every day at the time given. Because no schedule is specified for Data Collection, the default schedule will be used (Stand-Alone only).

**Default Schedules**

- Acoustic model optimization (ACO) — Every day, 3 AM
- Language model optimization (LMO) — Every day, 2 AM
## Editing Miscellaneous and Scheduled Task settings in nsdefaults.ini

Several settings from the Miscellaneous and Scheduled Tasks tabs of the Administrative Settings dialog box can be modified in the nsdefaults.ini file you created in "Installing the Dragon Group client" on page 64. You can then pass the revised file to the DEFAULTSINI option (see "Installing the same Dragon configuration on multiple computers" on page 68).

Many of the settings below are not available when NMS is enabled in the Dragon client. Administrators can control these settings in the NMC console.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO Archive Time Limit (Stand-Alone only)</td>
<td>Maximum audio archive size in minutes. The same option in the options.ini file for a particular user contains the size of the current audio archive for that user. Default max. is 3600000 minutes.</td>
<td>Archive Size dialog box, displaying the range of audio archive sizes</td>
</tr>
<tr>
<td>Disable command changes for restricted users=0/1</td>
<td>Turns on or off the option that lets non-administrative users add or modify commands.</td>
<td>Miscellaneous tab: Do not allow restricted users to add or modify commands check box</td>
</tr>
<tr>
<td>Disable vocabulary changes for restricted users=0/1 (Stand-Alone only)</td>
<td>Turns on or off the option that lets non-administrative users modify vocabularies.</td>
<td>Miscellaneous tab: Do not allow restricted users to modify vocabularies check box</td>
</tr>
<tr>
<td>Global Enable Pause Results=0/1 (Stand-Alone only)</td>
<td>Turns on or off recognition when the speaker pauses.</td>
<td>Miscellaneous tab: Record wave data between utterances check box</td>
</tr>
<tr>
<td>Custom Directory=&lt;full path&gt; (Stand-Alone only)</td>
<td>Sets the location of the Data Distribution directory used by the Data Distribution Tool or the nsadmin command.</td>
<td>Miscellaneous tab: Data Distribution location field</td>
</tr>
<tr>
<td>No Dictation=0/1</td>
<td>When No Dictation is on (set to 1) the user cannot dictate, but can correct dictation; used to designate an user as a transcriptionist.</td>
<td>Miscellaneous tab: Correction Only Mode checkbox</td>
</tr>
<tr>
<td>Global MyCommands MacroRecorder=0/1 (Stand-Alone only)</td>
<td>Allows or disallows the user to modify Macro Recorder commands. The user can use Macro commands, even when not allowed to modify them.</td>
<td>Miscellaneous tab: Disable use of Macro Recorder commands check box</td>
</tr>
<tr>
<td>Global MyCommands</td>
<td>Allows or disallows the user to</td>
<td>Miscellaneous tab: Disable use</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Setting</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>StepByStep Scripting=0/1 (Stand-Alone only)</td>
<td>modify Step-by-Step commands. The user can use Step-by-Step commands, even when not allowed to modify them.</td>
<td>of Step-by-Step commands checkbox</td>
</tr>
<tr>
<td>Global MyCommands VBA Scripting=0/1 (Stand-Alone only)</td>
<td>Allows or disallows the user to modify Advanced Scripting commands. The user can still use Advanced Scripting commands, even when not allowed to modify them.</td>
<td>Miscellaneous tab: Disable use of Advanced Scripting commands check box</td>
</tr>
<tr>
<td>enx ACO uses Auto Accent AM selection=0/1 (Stand-Alone only)</td>
<td>When set to 1, the Acoustic Optimizer engine can automatically select an acoustic model that it believes is more suited to your speech. To avoid having this switch occur, set the option to 0.</td>
<td>Miscellaneous tab: Disable automatic acoustic model selection in Acoustic Optimizer check box</td>
</tr>
<tr>
<td>Data Collector Batch Mode=0/1 (Stand-Alone only)</td>
<td>When set to 1, turns on a process that automatically collects data to help improve speech recognition in the future. The process sends recorded dictation and the corresponding text to Nuance over the Internet, but does not send any personal information. Collecting data for Nuance is optional.</td>
<td>Scheduled Tasks tab: Enable scheduled Data Collection check box</td>
</tr>
<tr>
<td>Allow Users to Optimize=0/1</td>
<td>When set to 1, automatically runs an optimization process on speech recognition for the currently open user profile.</td>
<td>Scheduled Tasks tab: Enable scheduled Accuracy Tuning check box</td>
</tr>
<tr>
<td>Allow Users to Configure Tasks=0/1</td>
<td>When set to 1, allows users to set the schedule for accuracy tuning and (for Stand-Alone users) data collection tasks. Otherwise, these tasks take place on a default schedule.</td>
<td>Let the user choose when to run Accuracy Tuning and Data Collection</td>
</tr>
</tbody>
</table>
Extracting MSI/MST Files from the Dragon setup.exe

Some minor releases of Dragon do not include an MSI file. Instead, the file is part of the setup.exe file. You can run silent installations from the command line with msiexec.exe or setup.exe – you don’t need to extract the .msi and .mst files. Use the following information if you are comfortable using .msi installers.

When you are using the setup.exe method, you must ensure that all flags and properties are within the same set of quotes, directly after /v, without a space.

Using .MST files, you can tailor the MSI installation without changing the setup.exe file that Nuance provides.

The following sample command line extracts the Dragon 14.msi file and the .mst files used for installing Dragon:

```
setup.exe /a /s /v"EXTRACTFILES=c:\temp\MSIfiles /qn"
```

Use the options below to extract .msi/.mst files from setup.exe. These options do not install any files, but rather extract an installable set of files into the server directory you specify. You can then use the extracted .MSI and .MST files in a command line to install Dragon.

| Option                        | Description
|-------------------------------|--------------------------------------------------
| /a                            | An administrative installation installs a source image of the application onto the network. For details, see https://msdn.microsoft.com/en-us/library/aa367541(v=vs.85).aspx.
| /v"<msiexec options>"         | Passes msiexec options to Windows Installer. See “MSI options for Dragon installations” on page 118 for details. This option is required when extracting the .msi files.
| EXTRACTFILES=C:\<fullpath>\   | Indicates the directory where the extracted .msi/.mst files are to be written. Enclose long path names containing spaces in quotation marks. Be sure to escape the each quotation mark with a backslash: ". This property is required to extract the .msi files. If the directory you specify does not exist, the installer creates it.

Here is a sample command line to extract .msi files from a single executable:

```
setup.exe /a /s /v"EXTRACTFILES-S=c:\temp\msifiles"
```

| /l<Windows Language Code>     | Creates an MST file for the language specified (for example, 1031.mst). The language codes supported for installing Dragon are:
|-------------------------------|--------------------------------------------------
<p>| 1031=German                   |
| 1033=English                  |
| 1034=Spanish                  |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1036</td>
<td>French</td>
</tr>
<tr>
<td>1040</td>
<td>Italian</td>
</tr>
<tr>
<td>1043</td>
<td>Dutch</td>
</tr>
</tbody>
</table>
Appendix B: Stand-Alone Mode Installation Options

Setting Roaming user profile options ................................................................. 132
Understanding Roaming user settings in nsdefaults.ini and roamingdef.ini ........ 133
  nsdefaults.ini settings ...................................................................................... 133
  roamingdef.ini options ..................................................................................... 135
Installing a Roaming user profile configuration on additional computers .......... 137
Setting Roaming user profile options

Use the following steps to create a roamingdef.ini file to be used for an MSI installation where the Roaming feature is enabled:

1. Install Dragon on a computer with Windows administrator privileges (see "Installing the Dragon Group client" on page 64).

2. In the Administrative Settings dialog box, accessed during installation or via the natspeak.exe commands ("Natspeak.exe Command Line Options" on page 1), click the Roaming tab.

3. Enable the Roaming feature options required in your environment. You must include the Master Roaming user profile location, set in the Network Directories field, and any necessary HTTP or HTTPS settings. For details on configuring the Roaming feature, see “Administrative Settings dialog box – Roaming tab” in the Dragon Help site.

4. Test these settings to make sure the Roaming user profile connection works.

5. Configure settings in additional tabs as needed.

6. Save your settings by closing Dragon.

7. Copy the encrypted roamingdef.ini or roaming.ini file (use whichever file is newer) and the nsdefaults.ini file created by this installation of Dragon to a separate location. By default, the .ini files are located in:

   C:\ProgramData\Nuance\NaturallySpeaking14
## Understanding Roaming user settings in nsdefaults.ini and roamingdef.ini

The settings below were created when you configured Roaming in the previous topic.

### nsdefaults.ini settings

You can edit these settings directly in the nsdefaults.ini file.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description and user interface equivalent</th>
</tr>
</thead>
</table>
| Roaming User 0=1               | **Enable** check box: Turns the Roaming feature on or off.  
Default 0 (unchecked) = Off |
| Roaming User Local Cache Directory="<existing directory>" | **Local directory (for cache)** field: Sets the location of the local copy of the Roaming user profile.  
The default location is: C:\ProgramData\Nuance\NaturallySpeaking14\RoamingUsers\ |
| Open User Large Collection=0/1 | **Display Classic Open User Profiles dialog** check box  
Default 1 (unchecked) = Off |
| Roaming User Restrict Local User Access=1/0 | **Allow non-Roaming user profiles to be opened** check box: Permits non-Roaming user profiles to be opened when the Roaming feature is active.  
Default 1 (unchecked) = Access restricted to Roaming user profiles only.  
This setting can prevent end-users from accidentally selecting a non-roaming (local) user profile. |
| Roaming User Incorporate Voc Delta=0/1 | **Merge contents of vocdelta.voc into network user profile when file is full** checkbox: When the vocdelta.voc file reaches 90% of its maximum size (1 GB), incorporates the contents of the local vocdelta.voc file into the Master Roaming user profiles (acoustic model for the user profile), without running the Acoustic and Language Model Optimizer. After it incorporates the contents of the file into the Master Roaming user profile, it clears that data from the local user profile, where new data is pulled from subsequent dictation. If the data is being incorporated when you open a Roaming user profile, the process can be time consuming.  
Default 1 (checked) = On  

**Dragon does not display a message when the vocdelta.voc file reaches 90% of its maximum size.** |
| Roaming User Limited Network Traffic=0/1 | **Access network at user profile open/close only** check box:  
Synchronizes the Master and local Roaming user profiles only when a user opens or closes the profile. This includes the changes a user makes locally from the Options dialog box.  
Default 0 (unchecked) = Off |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description and user interface equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excessive network slowdowns can be alleviated by checking this option because it limits multiple interim synchronizations of Local and Master Roaming user profiles.</td>
<td></td>
</tr>
</tbody>
</table>
| **Roaming User Always Break Lock=0/1**      | **Ask before breaking locks on network user profiles (recommended)** check box: Produces a prompt that states the user profile is locked and asks you to override the lock preventing users from opening a Roaming user profile that is already in use.  
Network problems can cause a lock to become “stuck” and not release.  
Default 0 (checked) produces a prompt.  
A setting of 1 breaks the lock automatically without producing a prompt. |
| **ASW Override=0/1** (ASW is short for Audio Setup Wizard) | **Set audio levels on each machine** check box: Runs a Volume and Quality Check on the microphone each time you open a Roaming user profile. This setting affects all users.  
Turn this option on if your users experience reduced accuracy because of differences in the microphone, sound card, and ambient sound levels at different locations.  
Default 0 (checked) = On                                                                 |
| **Roaming ASW Override=0/1**                | **Set audio levels on each machine** check box: Runs a Volume and Quality Check on the microphone each time you open a Roaming user profile. Set to 1 if the Roaming feature is enabled and **ASW Override** is 1.  
**ASW Override** and **Roaming ASW Override** should always have the same setting. |
| **Roaming User Save Acoustics =0/1**        | **Save acoustic information** check box: Sets whether acoustic adaptations made during a dictation session are saved.  
Default 1 (checked) = On: Master user profile acoustic optimization applies the acoustic adaptation data from dictation sessions to the acoustic model for the profile.  
When set to 0, the .usr and .sig files created during dictation are not saved. Master user profile acoustic optimization does not apply the acoustic adaptation data from dictation sessions to the acoustic model for the profile. |
| **Roaming User Copy Dragon Log=0/1**        | **Copy Dragon log to network** check box: Copies the dragon.log file from the Local Roaming user profile location to the Master Roaming user profile location at the same time that the program synchronizes the local and the Master Roaming user profiles.  
Default 0 = Off                                                                 |
| **Roaming User Do Not Copy Dra Files=0/1**  | **Conserve archive size on network** check box: Controls files available to the Acoustic Optimizer during synchronization.  
Default 0 (unchecked) = Off; Acoustic data files from the latest dictation session are available to the Acoustic Optimizer when the program |
## Appendix B: Stand-Alone Mode Installation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description and user interface equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>synchronizes the local and Master Roaming user profiles. Turn this option on to prevent the transfer of acoustic optimization data to Local user profiles.</td>
</tr>
<tr>
<td><strong>Roaming User Max Container Size=1000 MB</strong></td>
<td>Disk space reserved for network archive field: Controls the maximum size for each container directory in the Master Roaming user profile directory. Default = 1000 MB</td>
</tr>
</tbody>
</table>

### roamingdef.ini options

The options below are saved in the encrypted roamingdef.ini file and should not be edited directly. You can control these settings in the **Roaming User Network Location** dialog, accessed by clicking the **Add** or **Edit** buttons in the Network Directories section of the Roaming tab.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description and user interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Network Settings&gt;]]</td>
<td><strong>Display Name</strong> text field: name assigned to the network directory where Roaming user profiles are stored</td>
</tr>
<tr>
<td>location</td>
<td><strong>Address</strong> text field: Path to a network directory, web server, or secure web server where Roaming user profiles are stored</td>
</tr>
<tr>
<td><strong>HTTP Settings</strong></td>
<td></td>
</tr>
<tr>
<td>type</td>
<td><strong>Authentication Type</strong> radio buttons: <strong>Basic</strong> or <strong>Digest</strong></td>
</tr>
<tr>
<td>autoscheme=1</td>
<td>Indicates authentication is required</td>
</tr>
<tr>
<td>queryforuserpassword</td>
<td><strong>Prompt for User and Password</strong> check box</td>
</tr>
<tr>
<td>authuser</td>
<td><strong>User</strong> text field: &lt;domain&gt;&lt;username&gt; required to log in</td>
</tr>
<tr>
<td>authpassword</td>
<td><strong>Password</strong> text field: Actual password required to log in</td>
</tr>
<tr>
<td>followredirects</td>
<td><strong>Follow Redirects</strong> radio button: <strong>Never</strong>, <strong>Always</strong>, or <strong>Same Scheme Only</strong></td>
</tr>
<tr>
<td>keepalive</td>
<td><strong>Keep Connection Alive</strong> check box</td>
</tr>
<tr>
<td>locktimeout</td>
<td><strong>Lock</strong> field in the <strong>Timeouts</strong> area: Number of seconds after timeout expires to lock the connection</td>
</tr>
<tr>
<td>connectiontimeout</td>
<td><strong>Connection</strong> field in the <strong>Timeouts</strong> area: Number of seconds after timeout expires to close the connection</td>
</tr>
<tr>
<td>connectiontimeoutinactivity</td>
<td><strong>Type</strong> radio buttons in the <strong>Timeouts</strong> area: Set if you selected the <strong>Inactivity</strong> option.</td>
</tr>
<tr>
<td>connectiontimeoutabsolute</td>
<td><strong>Type</strong> radio buttons in the <strong>Timeouts</strong> area: Set if you selected the <strong>Absolute</strong> option</td>
</tr>
<tr>
<td>firewall</td>
<td><strong>Firewall and Proxy Servers</strong>: Set if a firewall is configured</td>
</tr>
<tr>
<td>Options</td>
<td>Description and user interface</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>proxy</td>
<td>Use Proxy Server check box: Set if checked</td>
</tr>
<tr>
<td>proxyserver</td>
<td>Network Location: URL to the web server</td>
</tr>
<tr>
<td>firewalltype</td>
<td>Type dropdown: Type of firewall, represented by a number (enabled if Use Proxy Server is checked)</td>
</tr>
<tr>
<td>firewallhost</td>
<td>Server text field: Name of server for the firewall (enabled if Use Proxy Server is checked)</td>
</tr>
<tr>
<td>firewallport=1080</td>
<td>Port: Port used by the proxy server or firewall – 1080 is the default (enabled if Use Proxy Server is checked)</td>
</tr>
<tr>
<td>firewalluser</td>
<td>User text field: Login name of the administrator that can access the firewall (enabled if Use Proxy Server is checked)</td>
</tr>
<tr>
<td>firewallpassword</td>
<td>Password text field: Password to log in to the firewall (enabled if Use Proxy Server is checked)</td>
</tr>
<tr>
<td>firewalldata</td>
<td>Firewall Data or Proxy Authorization text field: Special authentication string for firewall or proxy server, if applicable (enabled if Use Proxy Server is checked)</td>
</tr>
</tbody>
</table>

**SSL Settings**

<table>
<thead>
<tr>
<th>sslcertstore</th>
<th>Certificate Store radio buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>sslcertstorepassword</td>
<td>Certificate Store Password text field</td>
</tr>
<tr>
<td>sslcertstoretype</td>
<td>Certificate Store Type radio buttons (represented by a number)</td>
</tr>
<tr>
<td>useopenssl</td>
<td>Using OpenSSL check box</td>
</tr>
<tr>
<td>opensslcipherlist</td>
<td>Cipher List text field (enabled if Using OpenSSL is checked)</td>
</tr>
<tr>
<td>opensslcacafile</td>
<td>Certificate Authority File path (enabled if Using OpenSSL is checked)</td>
</tr>
<tr>
<td>opensslcadir</td>
<td>CA Directory path (enabled if Using OpenSSL is checked)</td>
</tr>
<tr>
<td>tls1</td>
<td>SSL Enabled Protocols check box: Version 1 of the Transport Layer Security (TLS) protocol</td>
</tr>
<tr>
<td>ssl3</td>
<td>SSL Enabled Protocols check box: Version 3 of the Secure Sockets Layer (SSL) protocol</td>
</tr>
<tr>
<td>ssl2</td>
<td>SSL Enabled Protocols check box: Version 2 of the Secure Sockets Layer (SSL) protocol</td>
</tr>
<tr>
<td>pct1</td>
<td>SSL Enabled Protocols check box: Version 1 of the Private Communications Transport (PCT) protocol</td>
</tr>
</tbody>
</table>
Installing a Roaming user profile configuration on additional computers

The default Roaming user settings you created in “Setting Roaming user profile options” on page 132 are transferred to your client computers only if you include the ROAMINGUSERINI option, set to roamingdef.ini. Use the full path to the file:

ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"

If you do not pass the ROAMINGUSERINI option, default settings are used. You must also include the DEFAULTSINI option, set to nsdefaults.ini, as shown below.

For installations using setup.exe, your command line may look like this:

setup.exe /s /v"SERIALNUMBER=#####-####-####-####-
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v C:\Logs\logfile.log /qn"

Enclose long path names containing spaces in quotation marks. Be sure to escape the each quotation mark with a backslash: \.

If you are using msiexec.exe to install, your command line might look like this:

msiexec.exe /i "Dragon 14.msi"
SERIALNUMBER=#####-####-####-####-
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\nuanceLogs\logfile.log" /qn

After you have completed the installation, verify that all options are correctly set on the client computer.
Appendix C: Database backups

About database backups ................................................................. 139
Disabling automatic database backups ........................................... 140
About database backups

If you are hosting your own NMC server on-premise, database backups occur on a regular basis at scheduled intervals automatically. The backup process places backup files in the C:\NMSDBBACKUP folder on the database server by default, unless you specified a different location during installation. The backup includes database objects, like sites and groups, and includes the Windows communication foundation service logs generated for each user account. Backups occur on the following schedule:

- **Transaction log backup**—Hourly
- **Differential database backup**—Daily at 2AM
- **Full database backups**—Weekly at 2AM

The database server retains one month of backups on disk. To retain more data, you must copy the files before the end of the month, when the backup process deletes files older than one month.
Disabling automatic database backups

Optionally, you can choose to disable the automatic backups and manage database backups yourself outside the Nuance Management Center. To disable automatic backups:

1. From the NMC menu button, select **System Settings**.
   The System Settings dialog box opens.
2. In the General section, select the **Disable scheduled NMS database backups** check box.
3. Click **Save**.